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Abstract 

The purpose of the internship, conducted through the Memorial University of Newfoundland 
Harlow campus, was to study the British Education System and its approach to integration 
of Information Technology (IT) in and across the curriculum. The intention was to furnish 
insights that may have some application to the curricular integration of IT in Newfoundland 
and Labrador schools. 

Chapter One of the internship report briefly examines the present condition and role of IT in 
the Provincial curriculum and offers some background to the place of IT in British education 
and curriculum. It also outlines the objectives for the internship and the activities undertaken. 

Chapter Two consists of a critical and reflective journal of information gathered and insights 
gained during the internship placement and the research process. 

Chapter Three contains a summary of the research component of the internship. It examines 
two approaches taken to the curricular integration of Information Technology in British 
schools (particularly in the two schools studied): a subject-integrated or totally cross­
curricular approach and a discrete subject approach. 

Interviews were conducted with department heads and lead teachers in the integration of IT 
at two schools of the Essex County Education Authority. A standardized list of interview 
questions was used. Data collection was triangulated using sources such as classroom 
observatio~ and document collection. Though there was less focus on classroom 
observatio~ the collection of documents was fairly extensive. Relevant and useful 
information was gathered from documents published by one of Britain's leading organizations 
in the field of educational technology, the National Council for Educational Technology~ 
accessed through Internet searches. 

Though further research is required to quantify the results, this investigation contends that a 
combination of these approaches would offer the most effective method for the teaching and 
application of IT skills within the curriculum. 
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Chapter 1 

Overview of Internship Report 

Background to the Internship 

With the wide-spread use of computer technology in the world today and its 

proliferation in industry particularly, one can understand the importance placed on 

teclmological skills. Most educators have come to recognize both the value of computer 

skills for their students and the potential that this technology has for delivering and extending 

the curriculum and their professional practice. 

The need for curricular integration of technology in the Newfoundland Education 

system has been documented over the years~ achieving prominence in the present milieu of 

educational reform. In 1979~ Crocker and Riggs called attention to the need for Technology 

Education as a component of curriculum: 

Each child should understand the function of technology in modem society .... 
Each child should acquire a basic knowledge of the major areas of technology 
and their impact on his or her life ... nothing in the existing curriculum deals 
with the technology . . . . A new curriculum approach is therefore needed .... 

(Crocker & Riggs, 1979) 

In 1992, Change and Challenge, a provincial government document, called for the following 

actions: 

Review and update course curricula at all levels ... to ensure that courses 
continue to be relevant to the changing needs of society and the economy by 
introducing new programs which focus on technology-based education ... by 
expanding the provision and use of computers and computer-based 
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technologies within the school system and developing a comprehensive 
information technology plan for the Department of Education and the school 
system ... 

(Govenunent ofNewfoundland and Labrador~ 1992). 

The govenunent documen~ Adiusting the Course: Part II, provided a rationale for the 

needed educational changes that will foster essential technical skills: 

Much of this change is being driven by technological advancement. One 
only has to think of the impact of the microcomputer, and the advances in 
communications technology and automation to illustrate the pace of 
change over the past decade or so. There is every indication that this pace 
is increasing .... Today's generation of workers has had to absorb the impact 
of the microcomputer, and the fundamental restructuring of the labour 
force due to automation and global competition. The changes in store for 
the next generation are no less profound and unpredictable. 

(Department of Education and Training, 1994a) 

Finally, the TILE document~ Technology in Learning Environments- Enabling 

Tomorrow's Learners Today (Department of Education and Training, 1994b) provided a 

vision for technological change. This document was the product of a comprehensive and 

strategic planning process and called for "integration of technology into and across the 

curriculum" (p.iii). Focusing on the major areas of curriculum development, curriculum 

implementation/delivery and learning resource management, TILE sought to provide a "clear 

statement of direction for the appropriate use of technology" in the school system and a 

"detailed series of projects, evaluations and pilots" for the integration of technology. It was 
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a philosophical and systemic shift in thinking and approach to technology in education. 

Using a strategic planning process, the ~E initiative delivered an analysis and 

summary of where the education system might evolve with regard to the integration of 

teclmology in the curriculum. It described the current levels of integration and mapped out 

the direction for future integratio~ curriculum development and professional development. 

It proposed a series of development strategies which broke down the overall goal of 

technology integration into seven areas: Policy Changes, Educational Support, Professional 

Development, Enabling Technologies, Technology Integration, Curriculum Management .. and 

Curriculum Technology Infrastructure. It was believed that these areas would facilitate an 

environment that could foster essential technological literacy while connecting students in a 

network of learning. In short .. it was a view that projected an education system that could 

prepare its students with the skills necessary to contribute meaningfully to society and to 

engage in lifelong learning. 

The conunitment to furthering the technological skills of our students is evidenced by 

the Canada/Newfoundland Cooperation Agreement on Human Resource Development 

(HRD). This joint federal I provincial initiative promoted innovative and creative activities 

in the human resource development field. Signed in January 1993, the HRD Agreement was 

developed to build uon the principle that economic development depends upon building 

excellence in people" (Johnson & Johnson, 1994). This five year, $42.9 million 

federal-provincial agreement has been a catalyst for long-term change in Newfoundland. It 
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sought collaboration with and strives to foster cooperative links between school boards. 

community colleges, business, labour and community organizations to initiate improvements. 

The HRD Agreeme~t has set several goals. They were: 

I. improvement of achievement and participation in science~ technology, 
and mathematics; 

2. improvement of written and verbal communication skills; 

3. assistance for educational and training institutions in responding to the 
needs of small business, and 

4. encouragement of a cooperative, working reiationship between 
educatio~ business and industry. 

(Johnson & Johnson, 1994) 

Four main programs we~e developed to further the economic and human resource 

development goals of the province. One of the focuses of the first progr~ Learning and 

Enterprise Culture, was to enhance school improvement efforts. Many improvement efforts 

today centre on the integration of technology in the school. 

The benefits of the HRD agreement have been chronicled by Prospects., a publication 

funded by this goverr..ment initiative. This is a journal that is: 

specifically designed to address issues in human resource development. 
This publication is a response to a need to inform individuals involved in 
education, business, labour and government of innovative initiatives taking 
place in the field of human resource development within this province. 

(Johnson & Johnson, 1994) 

Since its first issue, Prospects has reported the many school improvement efforts made 
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possible by the HRD Agreement. The funding allocated under this agreement has enabled 

improvement initiatives that have focused on various areas of technology in education. These 

have promoted technological support, expansion and innovation in provincial schools. 

Yet, in spite ofthe importance placed on teclmologicalliteracy and government efforts 

to foster i~ there are forces that constrain educators. More recently., down-sizing and 

restricted resources have resulted in a slowing down of the implementation of technology in 

education. With cuts to professional development programs, the majority of this province,s 

teachers have not had access to the training necessary to teach with technology. Also., with 

a significant proportion of the teaching force approaching retirement age, there is 

questionable inclination among older teachers toward acquiring such training. As well, many 

of the new teachers emerging from pre-service teacher education programs do not have the 

necessary course work in the curricular uses of technology as such training has not been 

required for graduation. Together these forces act in opposition to a systemic integration of 

technology in schools. 

Educational Technology in Britain 

Like Newfoundland, education in Britain today is at the forefront of media attention 

and political debate. The administration of its education system and the legal framework that 
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guides the system has recently seen many fundamental changes that continue to unfold. In 

this milieu, Information Technology (IT) has been developed as both an integrated and 

discrete subject area that has achieved a place of importance within the country's curriculum. 

Information Technology has emerged from the integration of previously separate 

technologies. IT refers to areas such as advanced micro electronics .. software technology~ 

advanced information processing, office systems, data communications and computer aided 

manufacturing and computer aided education (University ofPretoria, South Africa, School 

for Information Technology, 1997). Research has shown the many benefits inherent in the 

curricular use of IT. Studies by Britain's National Council for Educational Teclmology 

(NCET, 1995) has indicated that IT can have many positive effects on teaching and learning. 

For pupils there are frequently gains in motivation, presentation, questioning skills, problem 

solving information handling, and techniques of modelling. Teachers often find that (among 

many other gains) using IT can: 

• lead to rethinking teaching and learning strategies; 

• provide more opportunities for differentiation; 

• foster greater expectations of their pupils; 

• identify more opportunities for individual teaching and group work and 

• promote better understanding of their pupils' learning. 

(NCET, 1995) 

Given the educational opportunities offered by IT, it would be remiss of educators not to 
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explore the ways in which IT may be infused into the curriculum. The importance placed 

upon IT in Britain is indicated by the legal requirements that mandate its integration into each 

subject of the National Curriculum and by the ongoing research and analysis of 

implementation and delivery methods. 

Regulations and Rationale for the Internship 

Within the Master of Education program at Memorial University, candidates may 

choose an internship as a program elective after or near the completion of required course 

work. The internship consists of two components: a sequence of activities which are 

organized and supervised to provide the intern with the opportunity to exercise professional 

responsibilities associated with the professional role for which they are preparing; and a 

research report on some aspect of the area of study of the internship. The purpose of the 

internship is to facilitate the development of each intern's personal and professional 

competencies and his/her research and problem-solving skills while providing practical 

experiences that will elucidate the theoretical component of the program and offer 

opportunities for the evaluation of these competencies and skills (Memorial University of 

Newfoundland, 1996). 

The internship in the Britain's Essex County School System met with the guidelines 
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and goals for this program elective. The experiences gained were rich and diverse and offered 

the opportunity to put theory into practice. At the same time., valuable research skills and 

experience was attained. 

Conducted in Britain's educational environment of recent change and refo~ this 

internship provided an opportunity to compare similarities that existed between two different 

systems of education. Using British government documents, interviews with teachers in the 

Essex County School System and observations of classroom and teacher-planning practice, 

a national picture of British education was acquired. It was a picture of an education system 

that sought to reform itsel:( a curriculum that struggled to define itself and the curricular area 

of IT that hoped to instill its students with the technological skills that were viewed as 

essential in the workplace - skills that would propel the nation's industry to a competitive 

international level. 

Objectives for the Internship 

The intern hoped to acquire an understanding of IT integration in the Essex County 

School System and~ generally. of the British Education System. To this end, three main 

objectives for this internship were identified: 

I. to observe various projects, strategies and plans in place to foster the 
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integration of information technology in and across the curriculum at St. 

John's Comprehensive School in Epping, Essex county; 

2. to assess the systemic approach to IT integration taken by the Essex County 

School System and/or the British Government's Department for Education; 

3. to utilize this knowledge of IT delivery so as to improve understanding of the 

most effective means of IT integration in Newfoundland schools. 

The first objective was realized through interviews conducted with the IT Department Head 

and other Department Heads or individuals within the various departments who were 

considered lead teachers in the integration of IT. The second was achieved partly through 

the same method of data collectio~ but also through examination of literature from various 

sources, but chiefly from the British Government's Department for Education (ie. National 

Curriculum documents, etc.). It was also hoped that the experience in Britain could provoke 

a renewed look at the efforts for technological integration in Newfoundland and Labrador 

schools. However, the achievement of this final objective lies not within the scope of this 

report. It is hoped the this document can operate as a spur for further. quantifiable research 

on effective methods of IT delivery in this province's schools. 
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St. John's Comprehensive School in Epping afforded its own unique perspective for 

the study ofiT within the curriculum and supports the rationale for this internship. The on­

site supervisor for the internship, Mr. Edward Barnes., had only just recently been appointed 

head of the newly formed IT department, a department that had recently been distinguished 

within the umbrella curricular area of Technology Education. Though he would only officially 

take over his post in September of 1996, it became necessary at the end of the '95 -' 96 school 

year for Barnes to prepare and organize his department to offer new courses in Information 

Technology and to facilitate cross-cunicular integration of IT. This setting offered the intern 

the experience of seeing what is involved in organizing an IT department "from scratch,.,: 

auditing the present system of delivery; coordinating and enhancing school IT resources; 

making proposals and development plans; developing new curriculum; formulating a school 

IT policy statement; planning the physical layout and configuration of the school's computer 

systems; working with the various departments to develop and foster cross-curricular links 

with IT; and devising school inservice training for staff, all with a view to meeting specific 

National Curriculum requirements. The relationship with Mr. Barnes was at once 

collaborative and instructive~ offering the data and feedback necessary to focus and complete 

the research. 
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Internship Activities 

The focus of this internship was on the cross-curricular application of information 

technology. It therefore concentrated on understanding how IT was being integrated in each 

subject area and on studying the overall structure in place (hardware, software, inservicing 

. and technical support, etc.) to guide and facilitate the acquisition of essential technological 

skills in those subject areas: The period of the internship afforded opportunities to gain the 

practical experience of operating in a different school syste~ to observe and facilitate the 

administration of an IT department, to study the theories behind accessing technological skills 

through the curriculum, and, informed by those theories, to design curriculum for Information 

Technology. 

The internship has involved the following experiences: 

1. Attendance at three seminars, one hosted by an Educational Administrator of the Essex 

County school system and two others hosted by a representative of the Graduate Programs 

office of Memorial University's Faculty of Education. The aim of these seminars was 

twofold: to provide orientation to the British Education Syste~ including the 

administrative structure, the National Curriculum, assessment and testing, and the school 

inspection system~ and to facilitate and offer support for the research being conducted. 
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2. Observing three classes at St. John's Comprehensive where teachers were conducting 

subjects lessons that employed Information Technology. 

3. Conducting interviews at this school with the department heads of each subject area (or 

lead teachers in the use of IT within these subject areas) to determine the extent to which 

and in what ways IT was being used in their subject area and to gauge their attitudes 

toward the ability of the present system of IT delivery to meet the needs of students and 

teachers. 

4. Assisting Mr. Barnes in developing a ''Curriculum Map" of how IT skills are being taught 

across the curriculum at St. John's Comprehensive so as to assess whether the existing 

level of IT delivery met the attainment targets of the National Curriculum and school 

inspection standards and to determine the direction ofthe school's IT planning. 

5. Visiting two other schools in the Essex County system and interview the department heads 

(or lead teachers) of IT to assess that school's approach to the curricular delivery of IT 

with a view to assessing the differences in IT delivery across the system. 

6. Designing the word-pro~essing curriculum for the Year 7 discrete course in IT (included 

in Appendix A), drawing on subject-specific tasks in Language Arts to foster the IT skills 
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in a cross-curricular approach. 

The Research Component 

The original research design for the internship proposed a study of the curricular use 

of computers in the Essex County School System. A more specific focus soon emerged. It 

sought to identify the various approaches to the curricular integration of Information 

Technology and offer suggestions as to the most effective method(s) for the teaching and 

application of IT skills within the curriculum. 

The British National Curriculum contains specific requirements for IT. It is to be 

integrated into every subject area (with the exception of Physical Education). One approa~h 

to meeting these requirements was a cross-curricular integration that divided IT skills into 

components and allotted the responsibility for each of these components to various subject 

areas (subject areas that seem most suited to certain modes of IT use). For example, the 

English department would take responsibility for teaching word processing and desktop 

publishing skills; the design technology department would cover the control element of IT~ 

the Maths department would teach mainly spread-sheet skills but also some data base 

application; the Science department would use IT for data-logging and data base applications. 

Another approach to teaching IT skills has been to offer Information Technology as 
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a discrete course only. The IT department takes responsibility for administering courses in 

IT which focus on developing a general knowledge of all dimensions of Information 

Technology and a proficiency in required IT skills. There was evidence of an attempt to bring 

a cross-curricular dimension to these courses by using tasks from other subject areas to foster 

the IT skills and make them relevant. However, within these two approaches, other factors 

appeared to affect the effective integration of IT, namely instructional time, skills transfer, 

availability of resources and professional development. 

This internship experience probed the researchable questions related to the most 

effective means of teaching IT skills and integrating the technology across the curriculum. 

The essential questions were: 

1. Can IT be integrated into all subject areas without an initial foundation of IT 

competency in teachers and students and with only casual administrative 

support? 

2. Can IT skills be taught in isolation as a discrete course only (IT for IT's sake) 

in hopes that the skills will transfer to other subject areas? 

3. Which is the better of the two approaches? 

4. Can either of these approaches, operating independently, provide students 
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with the necessary IT competencies? 

The research component included an analysis of the literature on the subject of IT 

delivery and integratio~ a report of the data gleaned from interviews conducted with teachers 

and key participants and from personal observation, as well as some recommendations for the 

effective curricular integration of IT based on this data. A more detailed discussion of 

research methodology follows in chapter three. A summary report would likely provide a 

series of guiding principles for selecting the best method of curricular integration of IT. 

Overview of the Report 

This report, as suggested by the title "The Curricular Integration of Information 

Technology in the Secondary School System," focuses on the teaching of IT skills to junior 

high and senior high school students. Indeed, in the British Education system where this study 

was conducted, the terms "Secondary," "Junior High'" or "Senior High" are not commonly 

used to refer to the students from ages 12 to 17 or to the corresponding levels of schooling 

from grades 7 to 12. Instead, students aged 1 I to 14 complete Years 7 to 9 which fall into 

the level called Key Stage 3, while students aged 15 and 16 complete Years 10 to 11 within 

the level of schooling referred to as Keystage 4. Keystage 3 and 4., then, correspond quite 

closely with our ''Secondary'' level of schooling and the report is thus titled because it is 
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assumed that those reading this report will be doing so within the context of the 

Newfoundland and Labrador Education System and because this report hopes to be relevant 

within that context. 

This internship report will be organized into three sections. Chapter One seeks to 

offer a description of the internship setting to put this study into context. This chapter has 

provided a background to _and rationale for the internship., as well as a formulation of the 

research questions that have arisen from it. 

Chapter Two is comprised of the personal journal kept during the internship. It 

attempts to provide a reflective and critical discussion of the value of the internship activities. 

It offers insights gained from and a critical evaluation of the intern's experiences. Broader in 

scope than the particular area of research reported in Chapter Three, it also contains 

information on the administration of the British System of Education in generaL It is written 

as a chronological narrative~ most times in an informal, first-person style. It is not intended 

as a daily comprehensive journal of all internship activities. The dates chosen for individual 

entries are random and reflect moments in the internship process that warranted discussio~ 

provoked insight or produced useful information. Names used in the journal are fictitious and 

have been changed to ensure anonymity. 

Chapter Three has a more defined focus. It will form the research component on 

methods of the curricular integration of Information Technology. Again., the names of the 

participants in this study are fictitious and have been changed to ensure anonymity. 
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Chapter 2 

Critical/ Reflective .Journal 

AprilJO, 1996 - St John's Comprehensive School, Epping, Essex 

Topics Discussed: 

• Staffbriefings 
• Administrative structure and nature of St. John's school 
• Structure of the British Public Exam System ( GCSE) 
• Present system ofiT delivery (curricular integration) 
• Advantages/disadvantages of discrete course in IT 

Today I began working in the school to which I was assigned - St. John's 

Comprehensive School in Epping , a smaller town south of Harlow in the County of 

Essex. It is a school which educates students from ages 11 to 16, from Year 7 to 11. The 

Head Teacher (or "The Head''}, Mr. Albert White, introduced me to the whole staff in a 

briefing (a short staff meeting which they have every Monday morning). These "briefings" 

last only about 10 - 15 minutes usually and are for the presentation of important 

information to the staff The staff was briefed by one teacher, a "head of year'', who 

infonned the teachers of the particulars of several students' cases. This was informative 

and, I would think, helpful to the staff as they deal with these students in class. So often 

in the syste~ teachers are "in the dark" about vital information pertaining to the students 

that they teach. The briefing is an abridged form of the staff meetings held in 

Newfoundland schools which delivers only relevant information that stems from the 

workings of smaller committees or groups. 

The Head and the Deputy Head, Mrs. Judy Phillpott, put me in the care of Mr. Arthur 
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Taylor, one with the title of"Senior Teacher''. This position is an administrative one quite 

similar to our vice-principal's job except that there are three such positions, each one 

responsible for a different area of administration. I spoke with Mr. Taylor about the 

British School System in general and St. John's School in particular. He informed me that 

there are two other strands of administration: department heads (or curriculum leaders) 

. and year heads (or head of year). The department head is quite similar to, if not exactly 

like our own administrative position. The head of year is in charge of a particular grade 

or year leveL It seems that this position has ''pastoral" responsibilities which involve 

addressing the whole grade in assemblies (and perhaps working in collaboration with 

curriculum leaders on curriculum issues concerning the grade). 

At St. John's there is no guidance counsellor position. It is approached in an ad hoc 

and open manner with guidance responsibilities being shared by the head of year (in 

his/her ~'pastoral" capacity) and any number of teachers acting as ''mentors" in the 

school's mentoring program. 

This school is a denominational school, affiliated with the Church of England. 

However, though they are under pressure from the 1988 Education Act, this school (and 

others like it) does not necessarily impose a denominational character or Christian content 

to assemblies. 

I talked a little with Mr. Taylor of the British system of public exams - the General 

Certificate of Secondary Education (GCSE) exams. There are exams in all areas: arts, 

sciences, maths, humanities, etc. The level of difficulty in some of these exams is in 3 

tiers. The grade that a student can receive in any give tier of difficulty is set. So, the 

18 



grade one receives in a tier 1 exam will be either A orB; the student doing a tier 2 exam 

will receive a grade ofC or D; the tier 3 exam paper can only yield a grade ofE. 

I was introduced to Mr. Edward Barnes who is the newly-appointed department head 

for Information Technology (IT). Though he doesn't take over this position until 

September 1996, he is currently preparing a new IT curriculum p!an for next year. At 

present the school policy for the curricular integration of IT requires the English 

department to teach and utilize word processing and desktop publishing software, the 

Socials/Humanities department to teach database software, and the Science and Maths 

departments to teach dataqases and spreadsheets. So at the moment IT is across the 

curriculum. However, there is a rolling plan in place to establish IT as a discrete subject 

area in Years 7 - 9 so that students learn how to use the hardware and software and then 

have the skills to apply the technology in the higher grades. At present, there is no GCSE 

exam subject in IT but there are plans to establish an exam course in Business studies and 

IT. 

In order to establish IT as a discrete subject, Barnes has a plan to investigate just how 

IT is presently being used across the curriculum. He wants to create a curriculum map 

to detennine in what subject. areas and to what degree IT is being integrated. His research 

intentions coincide perfectly with mine and our work should compliment each other. 

I then had a meeting with Mrs. Annette Windsor, the department head of English and 

the acting head of IT, about how the English department was approaching IT. She 

informed me that right now in Year 7, for instance, they are allotting one hour per week 

to learn the basics of word processing and desktop publishing. She herself is responsible 
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for making sure the teachers deliver IT in accordance with the National Curriculum. She 

is all for teaching IT as a discrete subject in the lower grades7 but has some concerns 

about professional development. If the students come into the upper grades already 

knowing how to use the IT~ the teachers of those grades have lost the opportunity to learn 

the IT along with the students and yet would still be expected to apply the use of IT to 

their lessons. Without that crucial learning opportunity7 the subject teachers in the upper 

grades would need more professional development to get used to the teclmology and get 

over the uneasiness or fear of using IT. Mrs. Windsor is also findin& as is the case in the 

Newfoundland school syste~ that technical support staff are needed to relieve the IT 

teachers of some of the technical troubleshooting duties and free them up to teach. 

May 7, 1996- Meeting with Martin Richards: the Maltings, Harlow 

Topics Discussed: 

• Administrative structure of the British Education System 
• British School Inspection System (OFSTED) 
• National Curriculum 

A meeting with Mr. Martin Richards, a retired educator in the Essex system, provided 

a wealth of information about the English School System: 

Education in England is intensely politicized. Very ofteDy in fact most times~ 

educational decision-making is made not on research or on the basis of students' best 

interests, but on political ideologies. 

There are three tiers of responsibility when it comes to authority and decision-making 
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in English education: 

1) Central Government~ which is elected~ raises the bulk of educational revenue 

through taxation. It establishes the legal framework that guides the system. The 

government provides the funding which allows the Local Education Authorities 

(LEAs) to deliver service. However 7 current changes have seen antagonism toward 

the LEAs as government has cut influence and funding from them. 

The present government is committed to a "market" philosophy in education. 

Their model of education is based on a view of schools as small business enterprises, 

competing with each other for resources and "clientele". Schools that can market 

themselves as having the best reputatio~ offering the best "product and service .. will 

attract the best clientele. Far from fostering collaboration between institutions~ this 

philosophy has greatly detracted from co-operation in educatio~ nurturing feelings 

of competition and suspicion among schools. Some schools have accused others of 

"poaching"- drawing in students from outside their area. 

In addition to taking to itself increased powers in areas like curriculu~ 

assessment., inspection (through the Office for Standards in Education - OFSTED), 

and publication of league tables., the government has simultaneously delegated 

authority from the LEAs to the Governing Body of each school. 

2) Local Education Authorities - Local Education Authorities, like the Essex County 

Council, are also elected. They pay for educational service with funds from Central 

Government and from locally raised revenue. Locally raised revenue is subject to 
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"capping", limiting the amount of allowable local fund raising and ensuring a "level 

playing field". Though the LEAs retain a strategic planning functio~ they no longer 

provide the following services which have now been devolved to the Board of 

Governors and the individual schools: 

- hiring and firing of staff 

- responsibility for curriculum 

- decide ., decapitation" levels 

- decided building priorities 

- "targeting .. offunds 

LEAs now have to delegate 9 5% of their budget directly to schools on a per capita 

basis and have no scope for targeting or directing funds. Such functions are now 

being centralized with the Board of Governors for each school. 

3) Board of Governors- Each school has a Governing Body consisting of 10-20 

members. These members are partly elected.. partly nominated to represent the 

community, parents, teaching staff of the school, LEA, and Church. Members are 

unpaid volunteers. The duties of membership on the board are of a proactive nature, 

demanding major responsibilities in school budgeting, hiring/firing of staff: 

maintenance of the premises and accountability for standards. 

This power structure has resulted in increased local authority, but also in the mass 

resignation of governors (feeling they lacked the necessary skills and time) and tension 
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between Governors and Central Government. 

One of the functions performed by the Central Government is to regulate and 

oversee the inspection of schools in the British System. The process of inspecting schools 

has been privatized and is carried out by independent companies. The government 

oversees the professional activities of these inspectors through the Office for Standards 

in Education (OFSTED). .The inspection of any given school will take place generally 

every four years. The aim of these inspections is to evaluate and publish each school's 

effectiveness in order to improve quality, and assist parental choice of the best school in 

which to have their child educated. 

Inspectors are trained by OFSTED and work for privatized companies. Using 

given criteria, the inspectors observe many lessons, grade them and evaluate the school's 

performance. It is stressed that this examination is not an inspection of individual teachers 

but rather an aggregate of observations. They interview students, teachers, parents and 

Governors. They will examine: past work of students~ test performances, school policies~ 

planning processes, assessment and recording processes, and development planning 

processes. They also audit the school budget, resources and their use, community links, 

management systems, etc .. 

With assessment completed, the inspectors will then publicly report on the 

standards of pupils' achievements, the quality of the teaching and the pupils' learning and 

on all the factors in the school which contribute to these findings. Being made available 

to the parents, Governors, the LE~ local and National press, and the local libraries, this 

report must achieve objectivity and contains recommendations. Then the Governors are 
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required within six weeks to submit an action plan showing how they intend to effect 

improvements. Schools felt to be "at risk" or "failing" may be re-inspected. Continued 

"failure" may result in the appointment of an "educational association" to run the school 

in place of existing management. This has not yet happened and likely will not because 

it would be unlikely that outsiders could get things right when insiders have failed over 

. a long period. Unfortunately, there is no process for appealing the results of these 

inspection reports. Schools can merely file a complaint that they are unhappy with the 

results reported and observations made. The complaint is followed up but is not 

overturned. 

Recently an organization has been set up by a group of academics and former head 

teachers to inspect the school inspectors. The group, calling itself the Office for 

Standards in Inspection (OFSTIN), arises out of a feeling that these inspections are 

independent of government and politics. It is felt that statistics are slanted to suit the 

government's needs. Having no government power and operating like a consumer 

awareness group~ OFSTIN wishes "to challenge the fairness of the current inspection 

service and to question its value for money" (Rafferty, 1996, p.2). Carol Fitzgibbon, the 

director of the Curriculum, Evaluation and Management Centre at Durham University, 

heads the group and challenges that she has "yet to see evidence of reliable consistency" 

in the inspections. "Team member~ Mchael DufiY said: 'There needs to be an opportunity 

to apply the sort of checks OFSTED applies to registered inspectors to the whole 

organization.'" However, OFSTIN has not outlined the measures it can or will take. The 

organization is perhaps limited in its effectiveness and capabilities. 
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The statutory curriculum in England consists of: 

a) National Curriculum - The National Curriculum is prescnoed the Central 

Govenunent in core subjects, such as English, Maths and Science, and in foundation 

subjects like History, Geography, Design Technology, IT, Art, Music, Physical 

Education, Modern Language (for students over 11 years). AliSchools must uphold 

the National Curriculum. Testing of the National Curriculum and its results are 

published for "consumer .. decision-making on whose school is providing the best 

education. 

b) Religious Education - Religious Education is to be taught according to a locally 

established syllabus within the National Framework. All schools must teach religious 

education. The LEA will detennine the syllabus. All schools must have a corporate 

act of worship. The definition of"worship" is wide open. 

c) Cross-curricular themes are devised to show how important issues are carried 

across as well as within subjects. These include healt~ environment, business, and 

multicultural education. These themes are seen as threads running through the core 

and foundation subjects. There are no prescribed syllabi. Therefore, they are not 

legally binding. 

The time budget suggests that 15% be spent on each core subject with the rest of the time 

allotted for foundation subjects and religious education. Teachers protested the heavily 
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prescribed curriculum and hence, recent changes in the detail of the syllabi suggest that 

4 days be given to covering the National curriculum and 1 day for the school to "do its 

own thing11
• 

May 8, 1996 - St John ,s Comprehensive School, Epping, Essex 

Topics Discussed: 

• Drama and IT 
• Group work with computers: communication and collaboration 

My original internship proposal sought to focus on the areas of computer-assisted 

learning and drama education I theatre arts. Shortly after undertaking this internship, I 

realized that there was a paucity of research and educational endeavour in these areas. 

In pursuing this interest in the areas of computers and dram~ I spoke with one of the 

drama teachers at St. Jolm's, Andrew Thomas. Though quite interested in the possibilities 

of integrating IT and drama, he does not presently incorporate IT in his drama classes. 

We spoke at some length about my ideas and the research I have done in the area and he 

was quite willing to try a particular unit I have designed which integrates computers and 

drama if both our schedules will permit. 

I then attempted to contact by telephone the authors of a particular research study, 

Computers as Catalyst: A Report on Information Technology in Drama Contexts. which 

incorporated computers into educational drama (Manser, 1993 ). Their project has 

attempted to determine if IT can contribute to the "creation of atmosphere, symbol, 
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tension and mood within the drama .. and to what extent this would affect outcomes 

(Manser, 1993. p.5). I also am interested in exploring the innovative curricular partnership 

of Drama and Information Technology to assess how each may enhance the other. So~ 

given that Manser's study was conducted in Tower Hamlets~ a borough in East London 

(only an hour away from Harlow), I was hoping to speak with and perhaps visit and 

interview members of the research te~ using them as resource people to find answers 

to such questions as: How can the use of computer technology in the areas of drama 

education and theatre arts foster group communication? How can computers act as a 

catalyst in furthering the objectives of drama education? However~ my call was not 

received with great enthusiasm and I was unable to get any further than a brief telephone 

conversation with one member of the team. I was therefore forced to give up on this 

aspect of my IT research. 

Afterwards, I observed an English class taught by Mrs. Windsor, the English 

Department Head. This class was using IT as they completed a project where in small 

groups they designed their own magazine. Using software like Microsoft Publisher, 

IVficrosoft Word and a graphics package, the students devised the magazine cover, created 

graphics for the pages, designed the page layout and used the word processor to complete 

their written compositions. 

During this process, I noticed that students worked well together at the computer. 

There was a sense of group ownership of the product. Some students I observed were 

very conscious of ensuring that any decisions made concerning the magazine were 

approved by all, stating that 'it belongs to all of us'. I noticed in one case that even when 
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students disagreed with how another student was performing a certain operation with the 

computer, they gave him the mouse and waited patiently for him to try the manoeuvre 

before reclaiming the mouse to try it themselves in a more efficient way. 

May 9, 1996- StJohn's Comprehensive School, Epping, Essex 

Topics Discussed: 

• School assemblies 
• "Collective Worship" and the Education Act 
• IT a5 a discrete subject in year 7 
• Focus of the research interview process 
• TILE document - integrated/discrete approaches and professional 

development 

Today~ I sat in on an assembly presided over by Edward Barnes, the Head of Year 

8. This is one of the pastoral duties of the Head ofYear. These assemblies are held every 

Thursday and are attended by all the students in that particular year level. The approach 

to these assemblies, as with the approach to discipline in general~ seems more regimented 

and demands more order than is typical in many Newfoundland schools. The agenda for 

this assembly focused on enforcing the school's uniform rules~ pointing out to the students 

of their recent relaxed attitude toward the wearing of school uniform. The rest of the 

assembly was taken up with the distribution of commendation certificates for 

achievements and participation in various school activities (i.e. a dance competition). 

Edward and I discussed the dimension of"collective worship" as required by the 

Education Act. It is these assemblies that are targeted to deliver this "worship". Though 

I failed to pick up on it in the assembly I attended, Barnes said he accounts for this 
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worship with a "scratch-the-surface" moral reflection. He says this fits the government 

definition of''worship ... The issue ofworship is a thorny one because, though the English 

system is not a denominational syste~ there are denominational schools. St. John's 

Comprehensive School is one of them. According to the Education Act, they must 

provide for collective worship every day. But the notion of "worship" is very vaguely 

. defined. Do you assemble the whole school in one place for this worship? There is no 

place big enough in St. John's for such a gathering with the exception of the Physical 

Education Hall and using this would involve setting out a large number of chairs - a very 

time-consuming process. Can you provide for collective worship over the P A system? 

The problem here seems to be that the students and teachers in that school may not 

necessarily hold the same faith. If they broadcast the worship this way, they may be in 

violation of the people's rights. Also, these students and teachers can choose to "opt out" 

of this worship, making it difficult to broadcast it generally. 

Following the assembly, I sat in on Mr. Barnes's meeting with Ethel Jones, an 

Education Welfare Officer. She is responsible for following up on students who are 

absent from school. She usually deals with cases of parentally condoned absence. She 

is more than a "Truancy Officer" in that she seems to find herself with duties that are not 

unlike those of a social worker and/or counsellor. The Newfoundland Education System 

does not seem to provide for such a role in its administrative structure - at least not in 

such a proactive manner. They discussed the cases of several students that Barnes teaches 

or for whom he is the Head of Year. 

Mr. Barnes and I discussed his curriculum plans for the teaching of IT as a discrete 
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subject in year 7 (age 11 ). He outlined a basic structure for this course: As the first three 

weeks would be spent in setting students up with accounts on the school network these 

initial weeks would be spent by teaching the students about the computer and its 

mechanics through the use of diagrams. During this time, students would learn about 

hardware and peripherals. Once they have accounts and access to the network. they 

would begin learning about the processes of encoding and retrieving data. They would 

afterward move into learning the specific software applications that will be employed in 

the coming years in Key Stage 4 (ages 14 - 16). The aim is to make them proficient and 

knowledgeable about how ~e computer and the specific software works so that it can be 

applied across the curriculum in the high school subjects. 

From year 8 on, students get into a problem-solving approach to using IT, learning 

how computers can be used for tasking in various subject areas, with an increasing 

awareness of how IT impacts on our lives and changes society. 

I then asked Barnes about his plans to approach the issue of teacher professional 

development. He proposes first to design the IT curriculum for year 7 and then to put a 

plan in place to facilitate staff development and bring the teachers up to speed. 

As part of my research which coincides with Mr. Barnes's need to assess IT at St. 

John's School, I will interview the Curriculum Leaders in English, Maths, Science, 

Modem Languages and Humanities. My questions will be aimed at determining how IT 

is used in these subject areas whether the present level of IT delivery is effective for 

students' acquisition of IT skills and what skills they would wish to see fostered in a 

discrete IT course that students should be able to apply in the other subject areas. 
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In his estimation, it would seem that St. John's School is probably an .. average" 

school in the Essex School Systen:t with regard to the integration of Information 

Technology. It is fairly well-equipped with the technology, but needs co-ordination of 

those resources. Therefore, this will serve as a model school upon which I may base my 

research. However, I will be visiting other schools for comparative analysis. 

Following my meet4lg with Barnes, I had some personal thoughts and questions 

of technology integration as it relates to our own Education system: As proposed by its 

vision document, Technology in Learning Environments (TILE) (Department of 

Education and Training, Government of Newfoundland and Labrador, 1994a), the 

Newfoundland Education System seems to be moving away from the notion of teaching 

IT as a discrete subject. Does Tll..E account for any stage in its vision when students will 

be taught IT as a discrete subject? If not when will students learn these computer skills? 

Will the continuum of computer skills be divided up over each of the school years and 

successively built upon? If so, in what subject areas will these skills be taught? If they are 

to be integrated in all subject areas will there be an overlap in teaching these skills? To 

integrate it in all subject areas and provide for all the computer skills that way presupposes 

that all teachers will be computer proficient and able to teach those skills. What about the 

professional development needed to ensure that teachers are able to do this? What 

resources are available to facilitate PO? 
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May 20, 1996- St. John's Comprehensive School, Epping, Essex 

Topic Discussed: 

• PI~ for IT as a discrete subject in years 7-9 

Mr. Barnes and I discussed in a little more detail his plans for IT as a discrete 

subject next year. He sees his job as one of training the students in the basic IT skills as 

a discrete subject. It will then be up to each department and individual subject teacher to 

help the students apply those skills and learn how IT is effective in the subject area. 

Next year in year 7, he will approach IT· as if they know nothing and have had no 

exposure to it. He will then focus on the necessary skills and knowledge of the relevant 

computer applications. 

For next year, the year 8 students will not have IT timetabled as a discrete subject. 

They will continue to pick up IT as it is delivered now, by the various subject areas. 

In year 9, however, they will be taught IT as a discrete subject in order to prepare 

them for high school and possible examination options in IT. Barnes will pre-test to 

assess their knowledge of hardware, software, peripherals, input/output devices and so 

on. The course will then build on that knowledge and also look at the wider issues of IT 

and give them a glimpse of what would be involved in taking an examination subject in 

IT. It will attempt to put the network concept into broader perspective and identify how 

IT effects industry and quality of life. Both year 7 and 9 IT will be timetabled for one 

hour per week for a total of 36 - 3 7 weeks. 
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May 22, 1996 - St John's Comprehensive School, Epping, Essex 

Topic Discussed: 

• IT delivery- "Computer Lab" vs. Classroom Stand-alones 

Fallowing upon some of the interviews with teachers, I began to see a common 

concern which would also be of researchable interest. In an interview, Mr. James Colle~ 

Curriculum Leader for Humanities expressed his problem with the set-up or 

''arrangement', of computer ~dware in the school. He is not totally comfortable with the 

"computer lab, or network model for computer use adopted by the school. Having to re­

locate his students to a computer lab to make use of IT, he has found difficulty keeping 

students focused on the true meaning of the humanities task at hand. He questions the 

efficacy of the network model for integrating IT into the various subject areas and 

wonders about a more effective use of stand-alone computers in the classroom. He feels 

that in the Humanities they are inhibited by the network model; that by changing rooms 

to get to the computers~ they are sort of changing context and it becomes more of a lesson 

about IT than humanities. There is not a true integration where IT is seen as a tool for 

performing tasks in the humanities. IT becomes not just instrumental but an entity in 

itself: something of a "roadside attraction" (or distraction). 

Collett calls for a re-evaluation of the role of IT in the Humanities - what has been 

done with it and what can be done to enhance the Humanities with IT. There is a need · 

for a consensus or a balance between the teaching of IT as a discrete subject and its 

integration in the subject areas. 

An interview with Mr. Richard Elliott, Curriculum Leader for Modem Languages 
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echoed similar sentiments. In addition to feeling that the available hardware is not 

particularly suited to the teaching oflanguages because it lacks the needed audio capacity, 

Levy feels it would be ideal to have stand-alone computers in the classroom which can be 

incorporated into the classroom and into teaching. He finds it to be a needless distraction 

to move his class to the lab. 

An area, therefore, of further research could examine the efficacy of the network 

model for cross-curriculum IT integration versus that of stand-alone computers in the 

classroom. 

May 23, 1996- Meeting with Martin Richards: the Maltings, Harlow 

Topics Discussed: 

• Government I Teacher Relations 
• Teacher Training 
• GCSE Examination Boards 
• Government League Tables 

We arranged another meeting with Martin Richards to discuss concepts and issues 

that needed further clarification. The discussion yielded the following information: 

• The government department responsible for education is called the Department 

of Education and Employment. This title reflects the government•s view of 

education as a utilitarian business that caters to industry. 
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• Government IT eacher Relations: There are 4 or 5 teachers unions or associations 

in England, among them the National Union ofHead Teachers (NAHT) and the 

National Union of Teachers (NUT), the latter being the biggest. Contract 

negotiation is carried out by one National government committee consisting of 

representatives from each of the unions. The government however retains veto 

rights. 

Teachers are paid on a national scale and move up in yearly increments. 

There is however only one level of certification and corresponding salary scale. 

Further studies or professional development will not involve a higher certification 

or salary level. All teachers move along the same scale in yearly increments. 

However~ a promotion to Head Teacher, Curriculum Leader or Senior Teacher 

will result in being bumped ahead a few extra years on the scale in compensation. 

• Teacher Training: There are basically two routes of teacher training. Both 

beginning generally at age 18. One route would be to go to teacher college for 

a four year course that will involve 8 - 12 weeks of practicum. This would give 

the teacher a 8. A. in Education. Another route, taken be most secondary 

teachers~ would be to first do a B. A. in your subject area first and then take one 

year ofEducation studies which would be quite extensive in the practical side of 

teaching. 

• Examination Boards: These boards were originally set up by universities to 
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ensure the academic abilities of graduating students. They are now commercial 

organizations that gain income from exam fees and are still linked with 

universities. The boards are responsible for designing the CGSE examinations for 

the various high school exam courses. Each board produces its own set of exam 

papers. Head Teachers usually decide which board's papers Will be chosen for the 

school's students to write. In composing and correcting these exams, each board 

will retain a qualified professor of the particular subject being examined. This 

professor will act as Chief Examiner., though generally teachers are hired at extra 

salary to mark the exams. 

• Based on GCSE examination results which must be published to aid consumer 

choice of schools, the government devises League Tables. These Tables are 

prepared by the Department of Education and show how each school fares with 

student achievement. They are set up for easy comparison between schools and 

are based on the annual reports ofNational Curriculum. These are made public 

to show the differences between schools for consumer decision-making. 
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June 3, 1996- St John's Comprehensive School, Epping, Essex 

Topics Discussed: 

• IT curriculum development for discrete course 
• Cross-curricular approach to word-processing -

IT and Language Arts 

After some discussion with Mr. Barnes about other waysy outside of my research capacity, 

that I could help him in his IT development planning. We decided that I could design a 

part of the curriculum for the Year 7 discrete course in IT. He was planning a cross-

curricular focus in his delivery of the IT course. Given that my undergraduate background 

was in English Literature and Language Arts, I will take over the development of the 

word-processing component of the course where I will draw from subject-specific tasks 

in Language Arts to introduce and reinforce word-processing skills. I have decided to 

design a curriculum unit that will teach the Microsoft Word word-processing skills 

through such tasks as creating poetry, a resume and a newsletter. I will have students 

concentrate on creating poetry, revising and editing it and then formatting it in different 

ways for effective visual presentation (likewise with resumes and newsletters). (The 

completed curriculum unit has been included with this report in Appendix A). 
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June 6, 1996- Brays Grove School, Harlow 

Meeting with Mr. Vincent Ennis, Dept Head of IT 

Topics Discussed: 

• Nature of IT at Brays Grove School 
• IT delivery in a strictly discrete approach with little subject 

integration 
• IT skills taught in Years 7 - 8 

Prior to an official interview with Mr. Ennis., the following information came from 

a discussion of the school's information technology set-up: 

The school has only two computer labs .. with enough terminals (including several 

stand-alone computers) to yield a ratio of 12 students for every computer. This is behind 

the average ratio in the Essex County system of3 students to every computer. So they 

are "under-resourced". There is a problem with lack of facilities at Brays Grove. Vincent 

teaches all his classes in these two labs. There are 25 periods in a week. He has 22 

periods of contact time. Of the other three periods., one is actually used to teach another 

IT class. So the lab is in use 23 out of25 periods per week. This does not leave much 

opportunity for other subjects areas to gain access to and integrate IT resources in their 

lessons. A third lab would be needed in order to provide cross-curriculum access to IT. 

IT is taught as a discrete subject in Years 7 & 8. They are without IT training in 

Year 9 and then, can pick up IT again in Years 10 and 11 with an CGSE course in Office 

Procedures. Originally, the school looked at integrating computers across the curriculum 
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and in theory, Ennis feels, this is the best method of curriculum delivery. But~ in practice~ 

it does not work out that way, he says. Most teachers are not confident enough with 

using IT. They are willing to incorporate it in their teaching, but they are not trained. So 

it gets left non the backbumer11
• 

As an alternative, IT as discrete subject was opted for instead of the cross-

curricular approach. The basic skills that are necessary are taught in Years 7 and 8. 

Students are taught: 

• Word Processing - Students spend half the year on these important skills7 using 
Microsoft Word 2 and 6. 

• Spreadsheets - Using Excel~ students gather data and then display it in graphical 
form. 

• Data Bases ... Students are introduced to the wider implications of data collection 
and the Data Protection Act in Britain. Students construct databases of names 
and addresses of friends and relatives, of information on artists and painters, etc .. 

• Graphics - Using programs like Paintbrush and Draw, students will produce 
posters and greeting cards, etc .. 

There is also a unit taught on the Internet and E-mail. There is7 at present, one 

terminal with Internet access. Students may have E-mail sent to them at the school 

address. (This Internet terminal is only being used by about 4 members of the staff of 

Brays Grove though it is open to access by all teachers and they are encouraged to do so 

as the experience can only benefit the students and the school). This is a 5 week unit. 

which runs concurrently with a 5 week unit on the use of the flatbed scanner and scanning 

software. The classroom is divided into two groups for the units. Each group will 

complete both units. 
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Students also learn the use of a desktop publishing package, Aldus PageMaker. 

As a final project in Year 8, they will create a newspaper. 

Though IT is not used across the curriculum, Vmcent attempts to equip the 

students within the discrete subject with the general skills to apply to the other subject 

areas and he also tries to draw on and refer to other subject areas to oe the vehicle for the 

IT skills. Because of the workload involved in ensuring skills are taught in the discrete 

course, the compulsory IT components to be taught in the individual subject areas by the 

National Curriculum are the responsibility of those departments. However, without 

adequate resources, it seemed near impossible to me for each subject area teacher to fulfill 

the IT requirement stipulated by the National Curriculum. 

IT is taught as an 'Option' in Key Stage 4 in a course called Office Studies. This 

is a practical and useful course that teaches students all the skills necessary to function in 

an office setting. It also fulfills the Compulsory National Curriculum requirement that 

students be aware of the wider implications of IT in society. 
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June 26, 1996- Meeting with Patricia Jefford, Deputy Head, Passmores School 

Topics Discussed: 

• IT resources at Passmores School 
• Proposals for upgrading IT resources 

My meeting with Mrs. Jefford provided the following information about the 

school: 

• Wrth regard to teclmology in the schooL there is a department head of Technology 

who is responsible for all aspects of technology. Separate and under ~ there 

is a Coordinator of Information Technology- Mr. Ralph Myers. 

• Year 7 and 1 0 have a discrete course in IT 

• Passmores has recently acquired two laptops for Internet access as part of a 

program sponsored by the National Council for Education Technology (NCET). 

The purpose of the program under which this hardware has been supplied is to 

allow for Internet access to available online resources related to the subject areas. 

• The school has generic software for all subjects but also there is subject-specific 

software. 

• In current negotiations with the Board of Governors, the school is proposing to 

upgrade the existing IT facilities by purchasing 60 more stations for the 2 main IT 

labs. So many of these new computers will be used to upgrade the main labs but 

other computers will be allocated to each subject area in clusters of mobile 

machines. Profes~ional development will also be provided as part of this 

upgrading package. The school has to seek bids from 3 companies to deliver the 

required Professional Development sessions on the new equipment. 
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July 18, 1996- St. John's Comprehensive School, Epping, Essex 

Final Entry 

Topics Discussed: 

• IT Development Planning at St. I ohn ~ s - assessment, planning and 
implementation 

• IT curriculum development for discrete course - a cross-curricular 
focus to facilitate skills transfer 

• Newfoundland, Essex and IT: Similarities and Differences 
• Recommendations 

My research at St. John's Comprehensive School in the area of Information 

Technology across the curriculum has bee~ I believe, mutually beneficial for me and my 

cooperating teacher, Mr. Edward Barnes. It was my focus to determine to what extent 

computers were integrated in all subject areas of the British National Curriculu~ in 

particular in the schools of the Essex County CounciL At the same time, Barnes, being 

newly appointed to Head of the lnfonnation Technology (IT) Department, was attempting 

to assess just how IT was being used in his school. 

He was trying to ascertain the extent ofiT integration across the curriculum at St. 

John's School as a starting point to developing policies and programs for the new IT 

department. I was able to assist in auditing the existing system of IT delivery by 

interviewing each department heads to ask how and which IT skills were being fostered 

in their subject area. This was the type of data collection that I had intended for my 

research as well. 

Coupled with his own investigation and his administration of a questionnaire 

(concerning the staff's feelings about their level of IT competency), Barnes could use my 
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research to help make proposals and development plans7 and to formulate a school IT 

policy statement. It also aided in planning the physical layout and configuration of the 

school7
S computer systems as it identified teachers' demands on the system. By 

identifying the level of IT integration in each of the departments, He could also detennine 

which teachers and curricular areas could most benefit from his help in developing and 

fostering cross-curricular links with IT and staff inservice training. 

I was further able to assist Mr. Barnes and the school in developing new 

curriculum for discrete IT courses. The level of teacher IT competency in the school was 

not conducive to a solely subject-integrated approach. The extent of IT integration across 

the curriculum was not even sufficient to meet the legal requirements of the National 

Curriculum. Discrete courses were therefore necessary to ensure that students were 

developing the essential IT skills. In order to give the skills taught in the discrete course 

some relevancy and to assist with the transfer of these skills to the other curriculum areas~ 

the courses were designed to draw upon subject-specific tasks to foster IT skills. I took 

over responsibility for developing the word processing curriculum for the Year 7 IT 

course. I developed a unit to teach word processing skills by having students apply them 

to Language Arts tasks in poetry, resume and newspaper writing. This unit appears in 

Appendix B of this report. 

From my observations and interviews with leading IT professionals at St. John's 

School and other schools in the Essex County School System. a picture of a school system 

has formed that exhibits both similarities and differences relative to schools in 

Newfoundland and Labrador. The policies or vision statements that guide the 
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implementation of IT programs in Britain differ from Newfoundland's documented 

guidelines that pertain to IT. The British Education System has outlined policy to guide 

the integration of IT within the structure of the National Curriculum. Here they have 

specified within the Programme of Study (POS), the Strands and Attainment Targets, the 

Levels of Attainment and Statements of Attainment for each subject area the general level 

ofiT integration required. The requirements for IT are sometimes more specific in some 

subjects than others, but in any case has the weight of law. 

In this way, British system of education is apparently ahead ofNewfoundland's 

education system which specifies no requirements, policies or curriculum mandates for the 

integration of IT in all subject areas of the curriculum. Such a curricular mandate for IT 

could perhaps be beneficial for the province. As ye~ there is only a vision statement in 

the form of the Tll..E document, much of which has yet to be implemented. However, in 

the present milieu of educational reform in the province, the role of technology has moved 

to the fore and all indications are that these guidelines will provide an impetus for 

curriculum development. 

Technology is now given a new place of eminence in the curriculum. For years, 

the core of our curriculum centred on language, math and science. Yet, one of the 

principles of reform as dictated by the government document Adjusting the Course: 

Part II {Department of Education and Training, 1994a) makes technology synonymous 

with science and places it at the primary core of our curriculum: "At least 50% of the 

school program must be devoted to the primary core areas of language, mathematics and 

science and technology." Yet .. there is little indication of whether this new degree of 
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prominence has both a discrete-course and a cross-curricular focus. 

With regard to the degree to which the system is furnished with adequate 

technology, it seems that the Essex County schools may lag somewhat behind the 

Provincial system. The same discrepancies in levels of technology resources between 

individual schools exists in the Newfoundland system as it does in Essex. However, one 

. was left with the impression that on the whole, Newfoundland schools are equipped with 

more resources. Yet, what statistics I could find on the matter seems to put these two 

school systems on a more compatible level as to resource provision. In 1996, the 

provincial average for number of students per computer is 12 (Government of 

Newfoundland and Labrador., Department of Education, 1997). This statistic was broken 

down according to school district whereas a similar statistic for Britain was divided 

according to the school level. In 1993-94, according to a summary of a Department for 

Education and Employment Statistical Bulletin. Primary schools were reported to have 

a ratio of 18 students per computer, Secondary schools had 10 students and Special 

schools had 5 (Kilkie, M., 1995a). It is difficult, however, to get definitive statistics as 

to the type and age of the computers available to British students. Profiles '96 provides 

some breakdown as to the status of the computer technology available (Government of 

Newfoundland and Labrador, Department of Education, 1997). 

As well., educational telecommunications in Newfoundland are at far more 

advanced stages of development than the Essex County system. With development and 

implementation funding from the Canada-Newfoundland Cooperation Agreement on 

Human Resource Development (HRD), the Newfoundland government has instituted 
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STEM-N~ the Scien~ Teclmology Education and Mathematics network. STEM-Net 

is "a computer network for active professional K-12 and rural public-college educators 

in Newfoundland and Labrador. By assisting these educators in meeting their teaching, 

curriculum and professional development needs, STEM-Net aims to support their 

ongoing efforts to improv~ student achievement in this province'\STEM-Net, 1996). 

This "state-of-the-art provincial computer network, established in 1993, has greatly 

improved conununication among educators and has become the vehicle for many new 

initiatives in professional development" (Government ofNewfoundland and Labrador, 

Department of Education, 1997). STEM-Net users can avail of services which include 

electronic mail, general information bulletins and news groups, a wide range of on-line 

libraries and database resources., and access to the Internet and the World Wide Web. 

Educators at Memorial University's Faculty of Education, the province's public colleges 

and all ofthe K .. 12 schools·have long had access to the network. In 1996, STEM-Net, 

administered 9400 accounts, and "since the beginning of 1996 there have been over 

125,000 logins province-wide each month with a total of between 23,000 and 24,000 

hours connect time per month" (Government of Newfoundland and Labrador~ 

Department of Education, 1997). Through the financial assistance of government, 

STEM-Net is providing free access to E-mail and Internet to education professionals and 

pre-service teachers. It has also fostered projects that encourage the curricular use of the 
• 

Internet. 

Very few teachers in the Essex system seemed to have online access and fewer still 

were using the Internet as a teaching I learning tool in their schools. Internet access is 
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very costly and they have not had the benefit of government funding to fully subsidize 

these costs as Newfoundland has had. In any case~ it is hard to compete with the 

advanced system which Newfoundland has in STEM-N~ considering that it is on the 

leading edge in North American Education. 

In Britain, there have been some industry- and government-sponsored programs 

that have attempted to improve the schools' access to IT resources~ if their applications 

met certain criteria. St. John's Comprehensive School and Passmores School have 

recently acquired two laptops for Internet access as part of a program sponsored by the 

National Council for Education Technology (NCET). 

This program known as "The Multimedia Portables for Teachers Pilot, is funded 

by the Department for Education and Employment (DfEE), aims to build on existing 

research by providing teachers with portable computers which support multimedia and/or 

communications. Their research shows that using portable computers in schools: 

• encourages innovative approaches to teaching; 
• brings a flexibility to teachin~ extending the use of IT 

beyond the classroo~ and 
• allows teachers to develop their IT skills in private and 

to use the portable whenever and wherever is most 
convenient to them. 

(NCET~ 1997b) 

The project will evaluate the impact of this technology on teachers' competence and 

confidence in the use of IT. The pilot will be evaluated over a period of one year initially, 

beginning in September 1996. A total of 1141 teachers will be equipped with a portable 

computer and will take part in the project. 
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Those schools taking part in the pilot project were able to choose between two 

platforms - PC Compatibles and Apple Macintosh. All computers provided by the pilot 

are equipped with Internet access. The aim is to evaluate different types of access to the 

Internet and the experiences of the teachers using the PC portables. The purpose of the 

program under which this hardware has been supplied is to allow for student and teacher 

Internet access to available online resources related to the subject areas. The teachers in 

return agree to participate in an evaluation of the impact of this resource on teaching and 

learning. While these programs are helpful~ resources are limited and participation is 

determined through a selection process. This raises questions about equity of access. 

One is left with the view that in Newfoundland IT capacity is largely under­

utilized, particularly if one looks at true curricular integration. We share similar problems 

and impediments with the Essex system: lack of teacher competency (which is further 

undermined by lack of teacher inservice training) and lack of human resources within the 

schools to provide IT support, system maintenance and trouble-shooting. In short, both 

education systems have some distance to go before effective IT delivery can take place. 

However, this province could be doing more to exploit its wide range of present 

advantages described above. Some recommendations from improvement would be: 

• ensure that course work in educational computing is compulsory in the training 

of pre-service teachers 

• provide increased re5ources and opportunities for professional development in IT 
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skills, IT integration and the generation I composition ofHRD proposals for IT 

funding. 

• outlining policy that places a curricular mandate on (or at least resource manuals 

that guide) the cross-curricular integration of IT within the Provincial curriculum 

• including IT as a curricular subject from the elementary level onward to ensure a 

foundation of IT literacy that will facilitate IT use in the curriculum 

• recognition that IT support services within schools are essential and allocate 

funding at the school or board level to provide increased access to these services. 

Upon retlectio~ this internship has met with all my expectations and objectives. 

It has given me new insight into the methods of IT integration and the levels of IT 

resource provision at work in Newfoundland. While analyzing the systemic approach to 

computer integration taken by the British Education System and those particular IT 

strategies and policies of certain schools in the Essex School System, I have been provided 

a great opportunity for professional development. I have obtained valuable experience in 

the administration of IT delivery and in IT curriculum development. 
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Chapter3 

The Curricular Use of Information Technology: 
Discrete Delivery or Cross-Curricular Integration 

Background and Rationale 

In an information age where the human knowledge base is constantly changing and 

expandin& largely due to the proliferation of technology, it becomes increasingly 

necessary to be able to sort· through and make some sense of all the data that carries the 

aegis of knowledge. Students, therefore, in today' s schools must develop skills for 

lifelong learning. Among these skills are those necessary for handling and communicating 

information. 

An essential component of a child's education is technological literacy. 

Being literate involves making meaning from a variety of sources and 
communicating it to a variety of audiences. Increasingly, those sources 
and the communications means are technological in origin. Literacy 
in a modern society requires a high degree oftechnologicalliteracy. 

(Department of Education and Training, 
Government ofNewfoundland and Labrador, 1995). 

This compels students to become literate with the technology that helps us organize, 

measure, control., handle and communicate information. They need to develop the 

necessary skills for utilizing this technology to make the task of dealing with information 

easier. 

Hence, Infonnation Technology {IT}., that body of technologies we have come to 

group under this heading, begins to distinguish itself as a relevant curricular area in its 

own right. Infonnation Technology has been variously defined. Rice (1995) specifies IT 
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to be ''the use of computers, CD-ROM, laser disc, digital video, satellite communications~ 

telecommunications, etc. in the classroom, as well as access to databases, such as the 

Internet'' (p. 67). The School for Information Technology in the University of Pretoria, 

South Africa ( 1997) is another source that describes IT: 

Information· technology refers inter alia to areas such as 
advanced micro electronics, software technology, advanced 
information processing, office systems, data communications 
and computer aided manufacturing and computer aided 
education. 

Herring (1992, as cited in Ashley, C., 1994) defines IT as: 

technology that has emerged from the integration of the previously separate technologies 
of 

• computers, including microcomputers, work [sic] processors, and large 
main frame computers; 

• communications technology, including the telephone, satellite 
communications, video and computer communications., facsimile 
transmission (fax) and the field of fibre optics; 

• microelectronics 

• data storage technologies 

• networking technologies 

• technologies relating to robotics, AI, hypertext, remote sensing., voice 
recognition., artificial vision and scanning. 

The skills involved in this broad area of technology are obviously many and varied. 

Herein lies the challenge - to impart these various skills effectively so as to engage the 

learner and allow him or her to see the relevance of the skills, to use them in all subject 

areas where appropriate and to recognize the ways in which these skills may be employed 
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in different situations to solve problems. It is the role of the school to impart such skills 

and knowledge to students: 

Many schools today are aware of the exciting opportunities that IT 
affords to enrich the learning experience of students. But equally~ 
many are confused and uncertain how to proceed, hesitating between 
a number of apparently contradictory models of IT implementation and 
delivery. 

{NCET~ 1997a) 

This begs the question as to what is the best method of imparting these skills and what are 

the factors that influence the teaching and learning of these skills. What is the best 

approach to facilitate the most effective curricular use of information technology? 

As this area of technology emerged and distinguished itself from the general 

umbrella ofTechnology in the 1980's, a debate slowly arose in Britain about educational 

computing. It was between those educators who thought that the only place of computers 

in the curriculum was to enhance all subject learning and those who believed that IT and 

computers in their own right was now a valid subject for learning and furthermore that 

enhancement in other subjects was unlikely to raise students abilities in using IT tools 

above a very low ceiling (Kilkie~ 1995b}. Such tension is perhaps characteristic ofiT,s 

place in today' s National Curriculum as it is both a prescribed subject syllabus and a cross-

curricular medium or tool. It is interesting to note Kilkie's assertion of a limitation to the 

Lsubject enhancement' role of IT, where IT's inclusion as an enhancement to subject 

learning (without a discrete teaching of IT skills) has limited effectiveness for raising 

students' abilities in IT. 

As research was conducted within Essex County's School system from April to 
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June 1996y it became apparent to the author of this report that there was no consistent 

approach to the integration of IT. Various methods were tried with varying degrees of 

success. The schools involved had to walk the line between what approach is deemed 

most effective given the school's context (ie. availability of resources and administration's 

"best thinking") and what will cover the dictates of the National Curriculum. 

The National Curriculum was given the weight of law upon its inclusion in the 

Education Reform Act of 1988. This national framework for education prescribes ten 

school subjects, distinguishing between Core Foundation subjects, such as Englis~ 

Mathematics and Science and Foundation subjects, such as History, Geography, Modem 

Languages, ~ Music, Physical Education and Technology (divided into Design 

Technology and Information Technology). Specified for each subject are the knowledge, 

skills and understanding which students of different ability and maturity levels should 

have; the required skills and processes which must be taught to these students; and the 

arrangements for student assessment of these skills and processes. Within the National 

Curriculum, IT is delineated as a separate subject syllabus and also IT requirements are 

outlined in each subject syllabus. 

For the purposes of clarifying terminology, the categories for the age grouping of 

students in Britain are called Key Stages. There are 4 such groupings. Key Stage 1 spans 

students' ages 5 to 7, Reception to Year 2. Key Stage 2 covers students' ages 7 to 11, 

Year groups 3 to 6. Students aged 11 to 14 in Years 7 to 9 fall into Key Stage 3, with 

Keystage 4 covering students in Year 10 and 11, aged 15 and 16. 

The study of Information Technology is compulsory at every Key Stage from 1 
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to 4. In a separate IT subject syllab~ the National Curriculum specifies what educational 

opportunities and experiences with the use of IT that should be made available to students 

and the IT skills that each student should perform. These skills and experiences increase 

in complexity through the Key Stages. At the same time, IT must be integrated into all 

the subjects of the National Curriculum. The school must ensure that these IT elements 

are covered in the context of each subject area, but the National Curriculum does not 

prescribe the method of IT delivery. 

The National Curriculum outlines what needs to be taught in each of these Key 

Stages according to the Programme of Study (POS), the Strands and Attainment Targets, 

the Levels of Attainment and Statements of Attainment for each subject area. 

Programmes of Study provide information for the teacher about the ways in which they 

may teach the attainment targets and statements of attainment for a particular subject area. 

The POS outlines generally the content of what is to be taught as well as methods or 

approaches for teaching. An example of a POS for a discrete course in Information 

Technology for Key Stage 3 would be: 

Pupils should be taught to become critical and largely autonomous 
users of IT, aware of the ways in which IT tools and information 
sources can help. them in their work; understand the limitations of such 
tools and of the results they can produce; and use the concepts 
associated with IT systems and software and the associated technical 
terms. 

(Department ofEducation and Employment, 1995) 

Each POS is outlined by a number of Strands. These strands are very general types of 

skills within each subject area. IT, for instance, is subdivided into 5 strands: 

Communicating information, Handling information, Controlling, Measuring, and 
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Modelling. Each of these strands is in turn broken down into a number of Attainment 

Targets that more specifically indicate the type of activities that will foster these skills. 

Using IT as an example, some attainment targets for Key Stage 4 would be: 

• use IT to handle and communicate information in a variety of contexts. 

• apply their existing knowledge and understanding of measurement, control and 
modelling to a wide variety of contexts, in a range of subject or vocational areas. 

• increase their understanding of the social, ethical, moral and economic impact of 
technology. 

(Department ofEducation and Employment, 1995) 

The National Curriculum also specifies requirements for IT to be integrated into 

every subject area (with the exception of Physical Education and Religion). These 

requirements, however, are not overly prescriptive, only stipulating in each subject syllabi 

that "pupils should be given opportunities, where appropriate, to develop and apply their 

infonnation technology (IT) capability in their study of. . . " each subject (Department for 

Educatio~ 1995). In some subject syllabi, the curriculum requirements for IT are more 

specific with regard to the tasks to which IT skills should be applied, but generally it is 

non-prescriptive and is left to the schools to interpret and implement. This governmental 

thrust for the cross-curricular integration of Information Technology forces schools to 

confront the issue of effective IT delivery. 

Several approaches to meeting the National Curriculum's IT requirements have 

emerged. The two methods examined by this study are on opposite ends of a continuum, 

with combinations of both approaches falling somewhere in between. The two 

approaches examined for the delivery of IT skills in the curriculum are: 
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• a subject-integrated or totally cross-curricular approach - where IT is used to 
enhance learning in each subject area and all IT delivery is by subject teachers, and 
students receive no specific IT teaching at all, and 

• a discrete subject approach- where IT is delivered through a clearly defined .. 
taught programme as a separate subject. 

Some schools have entrusted the teaching of IT skills solely to this subject-

_ integrated method or cross-curricular approac~ where ideally the teachers of all subject 

areas would take every opportunity to integrate the use of IT in their lessons. This has't 

however, translated into an approach where only some subject areas take responsibility 

for instilling the required IT skills. Information Technology and its requisite skills are 

divided into components and allotting the responsibility for each of these components to 

various subject areas (subject areas that seem most suited to certain modes of IT use). 

For example, the English department would take responsibility for teaching word 

processing and desktop publishing skills; the design technology department covers the 

control element of IT; the Maths department teaches mainly spread-sheet skills but some 

data base application as well; the Science department uses IT for data-logging and data 

base applications. 

Another approach to teaching IT skills in these schools has been to offer 

Information Technology as a discrete course only. The IT department takes responsibility 

for administering courses in IT which focus on developing a general knowledge of all 

dimensions oflnfonnation Technology and a proficiency in required IT skills. There may 

also be an attempt to bring a cross-curricular dimension to these courses by using tasks 

from other subject areas to foster the IT skills and make them relevant. However, within 

56 



these two approaches, various factors (having to do with instructional time and skills 

transfer, availability of resources, opportunities for assessment and professional 

development) impinge upon the effective integration of IT. 

This study probes research questions about the most effective means of teaching 

IT skills and integrating the technology across the curriculum. Itrocuses only on these 

two methods ofiT delivery, employed by the schools studied, to determine the following: 

• whether a solely cross-curricular approach to delivering IT can be effective 

~ what level of IT competency is necessary for teachers and students and 

what level of administrative support is required 

• whether a solely discrete course approach to delivering IT can be effective 

• whether IT skills, taught in isolation the skills, will transfer to other subject 

areas 

• which is the better of the two approaches 

This study gathers narrative data from interviews with teachers on the relative worth of 

two approaches to IT delivery: a discrete subject or a cross-curricular approach. This 

type of interview data allows one to identify the strengths and weaknesses of these 

approaches. Coupling this with data from the literature and other published studies 

provides a tentative picture of the most effective means of IT integration. 

57 



Review ofthe Literature 

Given that the use of information technology in education very clearly exists within 

a social context, this inquiry sought understanding within a paradigm that accounts for the 

dynamics of such a context. This study was informed therefore by data collected using 

qualitative methods. The qualitative paradigm seeks knowledge construction within ''a 

world in which reality is socially constructed, complex and everchanging'' (Glesne & 

Peshkin, 1992, p. 6). 

Some would suggest that one's choice of research methods is not determined by 

the type of research question. Rather we adhere to particular methodologies given that 

they are conunensurate with our view of the world. 

Our constructions of the world, our values, and our ideas about 
how to inquire into those constructions, are mutually self­
reinforcing. We conduct inquiry via a particular paradigm because 
it embodies assumptions about the world that we believe and 
values that we hold, and because we hold those assumptions and 
values we conduct inquiry according to the precepts of that 
paradigm. 

(Schwandt., 1989, p. 399, as cited 
in Glesne & Peshkin, 1992, p. 9) 

Elliot Eisner (1990), in The Meaning of Alternative Paradigms for Practice, 

rejects the notion that there is one epistemology or way of knowing. He points to the 

pervasiveness of the "scientific method" and the dominant attitude that it is the only 

paradigm that can provide valid and reliable "knowledge". He calls for a "broader and 

pluralistic view of knowledge" which will "contribute to a less dogmatic view in our 

schools of what it means 'to know"' (Eisner, 1990, p.90). Eisner advocates the notion 
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of multiple ways of knowing ancL therefore, multiple intelligences. 

He recognizes the need for teachers to employ their 'ways of knowing' by 

researching areas of their own practice in what is called action research. Action research, 

conducted by teaching professionals., will produce "the kind of knowledge secured by 

those on the inside., working in local contexts and needing to act upon what they know'" 

(Eisner., 1990, p. 98). As Eisner points out, we are not looking for "dependable 

prescriptions for action, but . . . analogues to increase the quality of teachers' 

dehoerations." It will at least give us 'food for thought,' foster reflection that may inform 

our future teaching practice or curricular directions. 

This piece of research sought to determine teacher's perceptions of the curricular 

uses of computers and the extent and nature of their own use. Therefore, the qualitative 

research task of"coming to understand and interpret how various participants in a social 

setting construct the world around them"' (Glesne & Peshkin., 1992, p. 6) was well suited 

to the aims of this research. The objective of qualitative research is to ''gain access to the 

multiple perspectives of the participants" (Giesne & Peshkin., 1992., p. 6) and this study 

recognized the importance ·of these perspectives to an accurate picture of the curricular 

use of IT and the best methods of the teaching of IT skills. 

Several organizations and authors have been exploring and defining the curricular 

role of IT. The National Council for Educational Technology (NCET) is a British 

government-funded registered charity. Its role is to: identify the relevance of new 

technologies to education; evaluate the potential of new technologies to enhance learning 

and to raise standards; and promote, enhance and support the effective use of information 
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technology across all sectors of education. With information gleaned from their TV 

series~ Teaching and Learning with IT, broadcast in cooperation with the BBC~ NCET 

publishes 'TV fact sheets'. In their most recent fact sheet publicatio~ Access to IT.~ IT 

as a curriculum subject (NCET, 1997c)~ they recognize that IT is both a subject in its 

own right and a resource fo~ teaching and learning. Published after this present study was 

completed in Essex, this NCET document produced findings which are consistent with the 

findings to be outlined in this report and therefore will be discussed in more detail below. 

In another NCET publication (1997a), Delivering IT Capability, ten contrasted 

case studies are presented which detail unique approaches and solutions to the problems 

and opportunities associated with IT delivery. The methods used in these cases range 

from: 

• The 'centralised' approach where IT is delivered through a clearly defined taught 
programme 

• The 'skills core' and 'kick start' approach where a small central unit teaches IT 
skills which are then applied across the curriculum 

• The totally cross-curricular approach where all IT delivery is by subject teachers, 
and students receive no specific IT teaching at all 

This document also outlines the advantages and disadvantages of each model of IT 

delivery. 

Delivering IT Capability delivers the central message that effective delivery of IT 

at Key Stage 3 is dependent on the school context., that there is "no right way,, no 

generalizable blue print to be used in all situations. The type and effectiveness of the 

model used will depend upon the dynamics of.;. 
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the resources and spaces available, the commitment and effectiveness 
of the management team, the IT confidence and competence of staff 
in all subject areas, and the personality of the IT co-ordinator. 

(NCET, l997a) 

Regardless of the model adopted by the schoo~ this document notes some factors 

which seem to be essential prerequisites of successful delivery of IT. NCET recognizes 

the importance of: 

• full support of the senior management team 

• a high level of staff expertise and suitable training to maintain this 

• careful and systematic curriculum planning and interdepartmental liaison 

• a well thought out procedure for monitoring and assessment 

• appropriate technical support. 
(NCET, 1997a) 

Similarly, Rice (1995) focuses on one ofthese important considerations that, in 

addition to the choice of effective IT delivery methods, determine the success of the IT 

curriculum. In examining some issues that surround the integration of IT into the 

classroom, she highlights the issue of professional development (PO) and IT support and 

its effect on effective integration. Her study finds such support to be greatly lacking. Yet, 

the teachers she has interviewed showed "a strong desire for inservice programs and 

resource personnel to support their use of technology in the classroom and sufficient time 

to take classes and to learn on their own" (p. 79). Thus far in the development of IT as 

a curricular subject and tool, support and resources for PD has not been made a priority. 

The literature available pertaining to this area of study is scant. Indeed, 

Information Technology is an emerging discipline within education. This would likely 
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account for the paucity of research reported in this area. 

Method 

Various means of data collection were utilized in this study. The data was 

triangulated using data sources such as classroom observation, document collection and 

. interviews. Such triangulation of data helps to meet one of the criteria of credible 

qualitative research, that of confirmabi/ity. This helps reduce the risk of 

researcher bias in the data. Tapping these sources has allowed for a deeper 

understanding of the issues. Though there was less focus on classroom observatio~ the 

collection of documents was fairly extensive. Relevant and useful information was 

gathered from documents published by one ofBritain's leading organizations in the field 

of educational technology, the National Council for Educational Technology, accessed 

through Internet searches. 

Much of the data for this study, however, was gleaned from personal interviews 

with teachers in various schools in the Essex County Local Education Authority (LEA). 

A review of the literature by Jeffery et ai (1995) found that personal interviews were 

considered "the most effective approach to collecting data" as it enables the interviewer 

to probe and challenge participants' responses (p. 47). They acknowledged the potential 

bias in reporting interview data, given the interviewer's ability to influence participants by 

directing their responses. This study hopes to have limited such bias through 

standardized, structured interviews. 
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Participants 

This study took place in one school primarily, St. Jolm's Comprehensive School 

in Epping, Essex. This school under the jurisdiction of the LEA - the Essex County 

Council, covered Key Stages 3 and 4, with students aged 11 to 16. The participants in 

this study were drawn from the staffofSt. John's who volunteered to be interviewed. The 

names used in this report are fictitious and have been changed to preserve anonymity. 

Those interviewed were mainly department heads. However, regular classroom teachers 

were interviewed where they were found to be more knowledgeable about IT's use within 

the department in question. A total of thirteen interviews were conducted. 

A second site was also chosen to provide a contrast to St. John's School. Brays 

Grove School in Harlow, Essex was suggested by the newly-appointed department head 

of IT at St. John's as being a useful counterpoint for this study. Time did not permit 

extensive intetviewing at this school. However, the sole participant drawn from Brays 

Grove School was the department head who had been in the position for several years. 

He therefore was fully knowledgeable about the delivery of IT in this school, especially 

given the centralized approach taken. 

Two more interviews were conducted with leading IT resource persons in two 

other schools, St. Mark's Roman Catholic School and Passmores School in Harlow. 

These interviews added a little more depth to the perspective. However., the interviews 

were more superficial than those conducted at St. John's Comprehensive and Brays Grove 

given time constraints and therefore, little of these are used in this study. 
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Instrumentation 

The instrument used to collect data was a standardized list of interview questions 

which was asked of all participants. A list follows of the questions asked of the 

participants at St. John's School: 

1. How are you using IT in your department I classroom? To what purpose? (For 
Department head: How many teachers in your department are actively using IT 
in their classes?) 

2. Why are you using IT to achieve these aims? Why not some other method or 
medium? Does it necessarily help to achieve these aims better? 

3. To what extent does the available hardware meet the needs of your students? Do 
you feel that there is any upgrading necessary to meet your aims and goals? 

4. Do you consider the current method of IT delivery effective for students' 
acquisition of IT skills? 

5. Are you able to effectively integrate IT into your subject area? 

6. What factors (if any) detract from this integration? 

These questions only varied slightly when the interview was administered to the IT 

Department Head at Brays ·Grove given the different approach to IT delivery: 

1. How well equipped is your school with hardware and software to facilitate IT? To 
what extent does the available hardware meet the needs of your students? Do you 
feel that there is any upgrading necessary to meet your aims and goals? 

2. How is IT approached in your school - as an integrated or discrete subject? 

3. How are your teachers using IT in their classrooms? To what purpose? 

4. How many teachers in your school are actively using IT in their classes? 

5. Why are they using IT to achieve these aims? Why not some other method or 
medium? Does IT necessarily help to achieve these aims better? 
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6. Do you consider the current method of IT delivery effective for students' 
acquisition of IT skills? 

7. Are you able to effectively integrate IT across the curriculum? 

8. What factors (if any) detract from this integration? 

Procedure 

The interviews were conducted during the participants' preparation periods or at 

lunchtime and usually lasted about 3 0 - 40 minutes. The opinions and views of the 

participants were sought to piece together the picture of how IT was being delivered in 

and across the curriculum at St. John's. All interviews conducted were recorded on 

audio cassette and later transcribed for analysis. 

Given the subject-integrated approach to IT delivery at St. John's, another school 

was sought as a research site that used the discrete course approach to IT delivery in 

order to provide a counterpoint for comparison of methods. One interview was 

conducted at Brays Grove School with the Head of the IT Department in order to 

determine the extent and type of IT cunicular use. Time did not permit further interviews 

with other members of the staff. However, due to the strictly discrete course approach 

to IT at this schooL he was able to provide all the necessary data and no further interviews 

were really needed. 
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Discussion o(Results 

St. John's Comprehensive School has entrusted the teaching of IT skills solely to 

the cross-curricular or 'subject-integrated' approach. With this method of IT delivery~ 

the teachers of all subject areas should take every opportunity to teach their students the 

IT skills required for use in their subject area and integrate the use of IT as a tool for 

problem solving in their lessons. This has .. however .. translated into an approach where 

only some subject areas .. those that seemed most suited to certain modes of IT use~ have 

taken responsibility for instilling the required IT skills. 

From interviews with department heads~ it was determined that 'covering the IT 

requirements' meant that the English teachers took responsibility for teaching word 

processing and desktop publishing skills; the design technology teachers covered the 

control element ofiT; the Maths teachers taught mainly spread-sheet skills but some data 

base application as well; the Science teachers used IT for data-logging and data base 

applications; the Humanities teachers taught mainly data base management and 

interrogation; and the Modem Languages teachers used IT for word-processing, data base 

and spreadsheet work. Some IT work was also done to lesser degrees in the subject areas 

of art and music, but the IT use in these areas did not meet the National Curriculum 

requirements. 

In addition. with this approach in this school .. it was not clear if the IT requirements 

were being met at all Key Stages. An interview with the Department Head of Humanities, 

James Collett .. revealed that very little IT work was being done at Key Stage 4. In Key 
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Stage 4, Collett claimed it was difficult to timetable the use of IT because of a) the 

teachers' perception of shortage of instructional time in which to get the required 

curriculum covered and b) inability to access the network. 

As indicated., one of the difficulties with this approach was related to available 

instructional time. Subject teachers already felt pressed for time to meet the subject-

specific demands of the N~tional Curriculum. With this IT approach came the added 

pressure of teaching computer skills so that students may apply them to the tasks of the 

subject. Teachers had tended to regard the use of their class time to teach IT skills as 

detracting from what they believed to be more relevant subject demands. The inability to 

come to grips with the required instructional time had contributed to poor curricular 

integration of IT as all subject teachers did not give IT the attention it required. 

The subject integrated approach offered the added chalienge of the assessment of 

student learning in IT. As various departments and teachers were responsible for teaching 

the students different IT skills., it was very difficult to monitor individual student progress. 

However, the National Curriculum demands for the subject area syllabus of Information 

Technology required that each student be given a level of attainment on the scale of 1 to 

8. The various departments responsible for IT however failed to provide a comprehensive 

assessment of each students' IT attainment. 

Several teachers descnbed the school's approach to IT delivery and cross-curricular 

integration as ''an unsuccessful attempt." Their concern was that: 

. . . this approach has failed to meet all requirements of the National 
Curriculum and· to really provide an approach to the toot/medium of 
IT as a cross-curricular subject. The students fail to make the links for 
IT between subjects. IT skills are not transferring across subject areas. 
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(Personallnterview~EdwardBarnes) 

With IT components being ~farmed out~ to various subjects and in some cases~ some 

subjects having exclusive responsibility for a certain mode of IT use (ie. the use of data­

logging in Science), cross-curricular links were not being made to ensure the transfer of 

the students' IT skills in one subject to other subjects and to promote student awareness 

of the wider application of IT. 

As an added challenge to successfully implementing this method of IT delivery~ just 

about every member of the teaching staff must possess an adequate level of IT 

competency. They must be knowledgeable in the area of IT and comfortable with its use 

in their classroom. The ~ewly-appointed Department Head for St. John's~ Edward 

Barnes, reported (based on his own staff survey) that his staff did not possess a high level 

of IT confidence or competence. Barnes indicated that the teachers' lack of competency 

may be compounded by a feeling of lacking control when it comes to integrating IT in the 

classroom as students seem to know more than them or by a feeling that they may "ruin 

the system or machine" through wrong use. One teacher who admittedly had little 

experience with computers commentef:L ul personally don't use it much because I find that 

I can't get the structure from the lesson when using IT." 

Due to this lack of competency very few teachers were utilizing IT. Barnes claimed 

that those teachers using it were likely those who were self-interested. According to his 

investigations, there was mainly one teacher using IT in Maths; in English, mainly one 

teacher, in Modem Languages, mainly 2 teachers. Interviewing each department head at 

St. John's during this study, the number of teachers reported to be using IT was somewhat 
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higher than this: 

• the Maths department head reported that all 6 teachers in the department use IT7 
but to varying degrees; 

• Humanities also reported that all six teachers are using IT to teach information 
handling and database management; 

• Modem Languages set a target for IT use of at least 3 times a: year by all teachers, 
but 3 out of 6 teachers used IT more than that; 

• All 6 science staff members were using IT to some degree - four occasionally and 
"two regularly with some real meaning attached to it, (Personal Interview, Mr. 
Roger Perchard); 

• In Art, I out of 2 teachers were using IT to some degree; 

• The Music teacher used IT where possible; 

• The Drama department used IT only in the form of computerized lighting for which 
students could receive an IT attainment level 

• The Physical Education department made no use of IT, not being mandated to do 
so by the National Curriculum. 

There was a discrepancy between the new IT Department Head's perceptions of the 

extent of IT use and what was actually reported by each department during the interviews. 

The reasons for this discrepancy may have stemmed from a difference in opinion of what 

constituted true IT integration. Also, in a milieu of teacher accountability and impending 

school inspections by the Office for Standards in Education (OFSTED), some of these 

reported numbers may have been due in part to what the participant felt he or she should 

report. Regardless., lack of IT competency was an important factor which inhibited the 

cross-curricular approach to the degree necessary to enable effective integration at this 

school. 
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At St. John's Schoo~ unlike many other schools, the availability of IT resources did 

not really impede IT delivery. There VJere about 100 computers available for use - some 

networked, others stand-alone. They had a fairly up-to-date network of 486 computers 

which needed some upgrading to allow for the use of CD ROMs. However, Barnes felt 

that 

... at St. John's, it may not be so much a matter of upgrading the 
software and hardware but more so updating the aims and objectives 
for IT use under the guidance and support of the "new.. IT 
department so as to bring it in line with the National Curriculum 
requirements. 

(Personal Interview, Edward Barnes) 

Brays Grove School had opted to deliver IT using the discrete subject approach. 

IT skills were taught in a course designed specifically for this purpose. A set curriculum 

of skills and topics were selected. A discrete IT course was taught at Keystage 3 in Years 

7 & 8. Students were given instruction in the use of word processin~ spreadsheets, data 

bases~ graphics, and telecommunications. IT was also taught as an 'Option' in Keystage 

4. throughout Years 10 & 11 in a two year CGSE course called Office Studies. This was 

a practical and useful course that taught students all the skills necessary to function in an 

office setting. It also fulfilled the compulsory National Curriculum requirement that 

students be aware of the wider implications of IT in society. 

Mr. Vmcent Ennis, Department Head ofiT, accounted for some of the reasons why 

his school has decided on the discrete teaching of IT: 

Originally, the school looked at integrating computers 
across the curriculum and in theory, this is the best method 
of curriculum delivery. But, in practice, it does not work 
out that way. Most teachers are not confident enough with 
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using IT. They are willing to incorporate it in their 
teaching, but they are not trained, so it gets left It on the 
backbumer". 

{Personal Interview, Vmcent Ennis) 

Coupled with the problem of teachers lacking the required IT competency was the 

problem with lack of computer facilities. Brays Grove had only two computer labs, with 

enough terminals (mcluding several stand-alone computers) to yield a ratio of 12 students 

for every computer. This was behind what Mr. Ennis felt was the average ratio in the 

Essex County system - 3 students to every computer. He indicated that they were "under-

resourced". Mr. Ennis taught all his classes in these two labs. There were 25 periods per 

week in the school's schedule. He had 22 periods of contact time. Of the other three 

periods, one was actually used by another teacher to teach another IT class. So the lab 

was in use 23 out of25 periods per week. This did not leave much opportunity for other 

subjects areas to gain access to the lab and integrate IT in their lessons. A third lab would 

be needed in order to provide cross-curriculum access to IT. He had put in a bid for an 

extra lab which would run off the same server as the other labs. He figured the school 

would need to have 15 more stations if they were to reach to goal of having IT taught 

across the curriculum. 

At the time of the study, there was very little use of IT by teachers in their 

classrooms because the Computer Labs were used continually for discrete IT courses. 

However, Humanities had a small outdated network of I 86's (7 stations) but it was used 

mainly for wordprocessing. Science also had a similar network and it was used for a little 

Control Technology. 
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To counteract limited IT use resulting from lack of access7 the IT department 

consulted with the other subject areas to include content from those areas. In this way~ 

IT was used across the curriculum to a certain degree. Although IT was not integrated 

across the curriculum in the truest sense, Mr. Ennis attempted to equip the students within 

the discrete subject of IT with the general skills that they could apply to other subject 

areas. He therefore tried to draw on and refer to content or subject-specific activities 

from these other subject areas to be the vehicle for the teaching of IT skills. It should be 

noted that this still did not fully address the problems associated with teaching IT skills 

in isolation. This can make skills acquisition less relevant as they are not truly 

contextualized. The skills may not transfer to the other subject areas when the 

opportunities arise. 

Integration of IT across the curriculum was., however7 still required by the National 

Curriculum and expected in the school. Yet, because of the workload involved in 

ensuring skills were taught in the discrete course, the compulsory IT components of the 

National Curriculum to be taught in the individual subject areas were the responsibility of 

those departments. Lack of resources (time, IT hardware, IT support) did not allow Ennis 

to forge strong cross-curricular links in cooperation with the other departments. 

Regardless of National Curriculum dictates and the pressure of possible poor evaluation 

in an OFSTED school inspection., it would seem that Brays Grove School provided the 

best IT delivery it could given limited resources. 
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Limitations of the Stutiv 

One of the limiting factors to this study was the lack of time available to conduct 

further and more detailed interviews to assess other teachers' views of the successfulness 

of their school's approach to IT delivery. It would have been interesting to find out the 

department heads' perceptions of how effectively IT was delivered with a centralized 

approach and to what extent they were able integrate IT in their subject areas and draw 

on the students' foundation in IT skills. The study could have benefitted from the 

individual teachers' views on their role in utilizing IT tools, given the limited access they 

had to the IT resources. 

Recommendations 

Determining the best method for the curricular integration of IT will depend in part 

on the context and distinct character of the school setting. Any recommendation must be 

made with this acknowledgement. At both St. John's and Brays Grove, it was apparent 

that the current levels and methods of IT delivery were unsatisfactory and failed to meet 

the schools' goals and the National Curriculum requirements. In the case of Brays Grove, 

this was apparent by the inability and/or failure to integrate IT to a level necessary to meet 

National Curriculum requirements. It was also evident in the Department Head's opinion 

that "integrating computers across the curriculum ... is the best method of curriculum 

delivery." The feasibility of such an approach at Brays Grove was prevented by lack of 
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IT resources and low levels of teacher competency. 

At St. John's, their desire to improve the IT delivery at the school was evidenced 

by their plans to change those methods. With Mr. Edward Barnes appointed head of the 

newly formed IT departmen~ St. John's school was to implement discrete course delivery 

of IT, starting with the 1996-97 school year. However, Barnes had decided to employ 

both the integrated and disc~ete approaches to cover the required IT skills. He had then 

proposed that the school implement a discrete delivery of IT, while at the same time, 

building up the knowledge of software availability I compatibility and use of the 

computers among staff and students in order to develop an integrated approach with 

strong cross·curricular themes and links. The curriculum for discrete IT courses was 

designed and, as this report is being written, is presently being implemented. For the 

'96/'97 school year, there would be a discrete course in IT for Years 7 - 9. It would cover 

the continuum of IT skills across these years in word processing, database management, 

spreadsheets, desktop publishing, graphics, control, telecommunications and Internet. 

These skills would be grounded in the context of relevant tasks drawn from subjects 

across the curriculum. At Key Stage 4, there were no IT courses at the time of the study, 

but there were two planned approaches for implementation in the '97/'98 school year: 2 

year GCSE exam courses in either IT alone or a combined IT and Business Studies. 

Mr. Barnes had also planned professional development in-service to foster teacher 

competency and, in tu~ curricular integration. This should address the concerns of one 

teacher, Mrs. Annette Windsor, former co-ordinator of IT for St. John's School She 
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readily supported teaching IT as a discrete subject in the lower grades, but had some 

concerns about professional development. She felt that, if the students come into the 

upper grades already knowing how to use IT., the teachers of those grades have lost the 

opportunity to learn the IT- along with the students and yet would still be expected to 

apply the use ofiT to their lessons. Without that crucial learning opp-ortunity., the subject 

teachers in the upper grades would need more professional development to get used to 

the technology and get over the uneasiness or fear of using IT. 

Admittedly, schools must account for their own individual contexts in deciding 

which method of IT delivery would best suit the needs of the schooL A number of factors 

influence which is the most appropriate model for a school's delivery of IT: 

• the commitment and effectiveness of the school management team; 

• the level of resources and their locations; 

• the IT competence., knowledge and confidence of the different subject 
teachers 

• an adequate number of well trained and qualified IT specialist teachers. 

"There is no one right way for a school to enable pupils to acquire these skills. However~ 

learning the underlying concepts and processes is most effectively taught as a separate 

subject but relating the work to the wider curriculum" (1997c). There are schools which 

use the subject-integrated_ or the discrete course method with great success., but the 

publication by NCET (1995), Approaches to IT Capability, warns that there are dangers 

with either approach. 

IT courses can lead to thorough but sterile coverage of IT~ while fully 
cross ... curricular IT can lead to many pupils missing out on certain 
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aspects of IT; or not making any progress beyond learning 
rudimentary skills. A way of avoiding these two extremes is to develop 
a carefully designed IT CQurse together with appropriate consolidation 
across the curriculum to enhance learning in the other subjects. 

(NCET~ 1995) 

The data appears to suggest., then., that the new direction taken by St. John's 

Comprehensive School would provide the most effective curricular integration of 

Information Technology. (However, further research may be needed to obtain 

quantifiable data to support this suggestion.) It offers the strengths of both approaches 

while one method in this combined approach compensates for the weakness of the other. 

The discrete course in IT would provide students with the foundation skills they need. 

This will reduce the instructional time needed for the teaching of IT skills and allow 

teachers to use IT as a problem-solving tool. With discrete course skills linked across the 

curriculum., the road to subject integration is made easier. "Teaching specific skills and 

concepts within a context .. or an IT activity that can be related to other tasks carried out 

elsewhere in the curriculum.. often increases pupils' understanding of the wider 

applications of IT' (NCET .. 1997c). IT teachers can then work with other subject 

teachers to help them integrate and contextualize IT.. develop cross-curriculum links and 

provide opportunities for professional development. 
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Summary 

Implementing one of these two IT delivery approaches over the other will not afford 

the students a complete education in the use of IT. To be completely effective and totally 

integrated across the curriculu~ a school~ s IT delivery should employ both a discrete 

course approach and a subject-integrated approach. A discrete course~ where students 

are given a foundation in essential IT skill~ will cut down on the loss of instructional time 

in other subject areas. Teachers won,t have to be concerned with teaching the basics, but 

can get right to the task of employing IT as a tool in problem-solving. 

However, the discrete course alone will not account for true integration of IT into 

the curriculum. The knowledge imparted in this course must have a focus. 

It is important for us as educators to impart knowledge, but 
knowledge with purpose and direction. The "why" of education is 
quite often over looked in search of knowledge. Knowledge needs 
direction to reinforce and give purpose to information ... 

(Biieske., 1996) 

Even if the course utilizes a cross-curricular focus and applies IT to subject-related tasks, 

this will have only limited effectiveness as the subject-related tasks are performed out of 

context. The transfer of these skills for use in other subject areas is not ensured unless the 

use of the skills are demanded within the context of the individual subject areas. 

Therefore, there must be, in addition to the discrete course, an honest attempt at IT 

integration in each subject within the curriculum. 

True integration is hampered by the limitations of the curriculum and the lack of 

opportunities for professional development. Without in-service and pre-service training 
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in the use oflnfonnation Technology in teaching and learning, we cannot hope to achieve 

cross-curricular integration of these technologies. Educational reform should also address 

the issue oflT, s place within and across the curriculum. Until universities, governments, 

schools, and professional teaching associations address these issues, IT education will 

have limited effectiveness in our schools and IT skills limited application to the wider 

world of work outside the confines of the schooL 
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Activity 1 

Writing a Poem 

Poetry has a way of saying something meaningful and significant using 
language in an original way. Poetry can be described as painting pictures 
with words. You try to capture a scene and/or a feeling by describing it and 
making it come alive for another person. Language can be used that 
appeals to our senses - words which give images that one can see, hear, 
taste, touch, smell. For example: 

• see - The summer flowers bow to each other and dance in the 
lakeside breeze. 

• hear - The chainsaw snarled and rattled in the backyard. 

• taste- The little boy squirmed as the lemon juice seized his taste 
buds. 

• touch - Sue felt a moist brush of sandpaper roughness on her cheek 
as her eat's tongue roused her from sleep. 

• smell - Fresh baked bread wafted its warm doughy scent throughout 
the house. 

Now start thinking about a poem that describes the sights, scents, sounds, 
tastes and touches of any topic you choose or of one of the following 
topics: 

• An Outdoor Market (What noises do you hear? What do the people 
dress like? What colors do you see? What do you smell? Is it a hot 
or cold day? How do you feel? Etc.) 

• After a Spring Rain Shower (What do the grass and trees look like? 
What do you smell? How does it feel to walk through the streets 
and/or the fields? Etc.) 

• Autumn (What are the colors, sights, sounds, feelings and ideas that 
come to mind when you think of autumn?) 
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• Starting the School Year (How do you feel? Nervous? Excited? 
Disappointed? Who will be there the first day? What are the noises 
you will hear? The sights you will see? etc.) 

Word Processing Your Poetry 

Word Processing Skills used: 

• loading the program 
• entering text from keyboard 
• highlighting text 
• cutting and pasting text 
• saving your document 

A Word Processor can help us to organize our ideas and to present them in 
a readable, attractive form. We will use Microsoft Word 2.0 to record our 
ideas about our poem as they pop into our heads as we brainstorm about 
our topics. So, ... 

1. At the Program Manager window, load Microsoft Word 2.0 by double 
clicking on the Word icon with your mouse. 

2. Once you have the program running, start typing into the computer as 
they occur to you all your ideas about the sights, smells, sounds, tastes 
and touches of your topic. 

3. When you have collected so many ideas, images or phrases, you may 
want to rearrange them in a different order or combine them to create a 
certain flow, effect or meaning to your words. Here is how you can 
move these words or phrases around: 

• use your mouse to point to the first letter in the word or phrase 
you want to move. Holding down on the left mouse button, · 
drag your mouse across the word or words, you want to move, 
highlighting them in black. Release the mouse button. 

• With the mouse, click on the Edit menu at the top of your 
screen. Select Cut. The word or phrase will disappear. 

84 



• With the mouse pointer, click to place the cursor where you 
want the word or phrase to appear. Click on the Edit menu 
again and· Select Paste. The word or phrase will reappear in 
this spot. 

Try moving things around using this method. 

Saving your Poem 

Now that you have a start on your poem, you will want to save it to work on 
it again later: 

1. Use your mouse to open the File menu and select Save. Name the new 
file you have started poem1.doc and click OK. A window will then 
appear, asking you to give more details on the type of file you are 
saving. At the title line, type poem1.doc. Click on the subject line 
and type word processing poetry. Click OK. 

Activity 2 

Formatting your Poem with the Word Processor 

With the final draft of your poem completed, you may now begin to format it 
with the word processor to make it look presentable. Your poem should 
appear in the centre of. the page, centred from left to right, top to bottom. It 
could look like the formatted poem on the following page: 
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The Writer of This Poe01 

The writer of this poem 
Is taller than a tree 
As keen as the North wind 
As handsome as can be 

As bold as a boxing-glove 
As sharp as a nib 
As strong as scaffolding 
As tricky as a fib 

As smooth as a lolly-ice 
As quick as a lick 
As clean as a chemist-shop 
As clever as a ./ 

The writer of this poem 
Never ceases to amaze 
He's one in a million billion 
(or so this poem says!) 

Roger McGough 
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Activity 2 (contd.) 

Formatting your Poem with t.he Word Processor 

Word Processing Skills used: 

• loading the program 
• entering text from keyboard 
• highlighting text 
• changing font and size of characters 
• using the TAB key to set out work 
• using Page Set-up and Section Layout 

to change margins and vertically centre text 
• using the Spell Checker 
• saving your document 
• printing your document 

Trying formatting your poem in the same manner as the poem on the 
previous page: 

1. Load the Word program from the Program Manager window by double 
clicking on the icon. 

2. Once you have loaded the program, use your mouse to open the File 
menu and select Open. From the Filename window, select poem1.doc 
or type poem1.doc at the filename line and click OK. 

3. You should type the title of your poem at the top on a separate line 
followed by a space. Your name should follow at the end of the poem 
after a line space. 

4. Change the font size and style of the title of your poem to distinguish it 
and make it stand out: 

• Highlight the title of your poem with your mouse pointer as you did 
when cutting and pasting (in Activity 1 , step 3). 

• Click on Format to show the menu and select Character. At the 
Font box, click on the down arrow to show all the different types of 
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font styles you can choose from. Scroll through them and select 
one. The sample window should show you what it will look like. 

• Click on the arrow next to the points box and select 18 for your 
font point size. Click OK. 

5. Indent your name at the bottom of your poem to set it in from the left 
margin: 

• Use the mouse pointer and click at the beginning of your name to 
place the cursor 

• Press the tab key 2 or 3 times to move your name in from the left. 

6. Try to adjust your left margin so that the poem appears to be 
horizontally centred on the page (that is, centred from left to right on the 
page): 

• Open the Format menu at the top and select Page Set-up. 

• Click in the left margin box and change the value to 3" . Click 
OK. (Note: You may have to adjust this value. Perhaps 3" may 
move the poem in too far or not far enough from the left. It may 
not appear in the centre of the page. To check how it will 
appear from left to right on the page, open the File menu and 
click on Print Preview. You may have to go back and readjust 
the left margin value.) 

7. Now adjust the poem so that it appears to be vettically centred on the 
page (that is, centred from the top to the bottom of the page): 

• Open the Format menu at the top and select Section Layout. 

• In the Vertical Alignment box, select center. Click OK. 

B. Check the spelling in your poem and edit any mistakes: 

• Open the Tools menu and click on Spelling. You may be 
asked, "Do you want to continue checking at the beginning of 
the document?" Click Yes. 

• The words that the Spell Checker will question are not 
necessarily spelled wrong. You will have to use your judgement 
on this. The Spell Checker will present you with suggestions for 
changing the spelling of certain words. You must click on the 
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corred suggested word and click Change (if the word is 
misspelled and you wish to change it) or you can choose to click 
Ignore (if the word is actually spelled as you mean to spell it 
and you wish to ignore the suggestion). 

Read through the poem once again and make sure there are no spelling 
mistakes or typing errors. This should prepare your poem for presentation 
in a nicely readable format. 

Saving Your Work 

If you have not done so already, you should save your work now. It is 
recommended that you should save your work often to avoid losing it if 
something goes wrong with your computer or with the network. Saving 
your work every 10 - 15 minutes is a good practice. 

Do you recall how to save your work from Activity 1? Try to do so. Another 
quick and easy way to save your work would be to take your mouse pointer 
and click on the icon (picture) of the floppy disk in the top left comer of your 
screen (the third icon from the left on the toolbar). 

Printing Your Work 

With your poem completely formatted, try printing it. 

9. Open the File men~ and select Print Preview. This will give you a look 
at how the whole page should look when printed. Ensure that the 
centering of the poem looks right from left to right, top to bottom. You 
may have to re-adjust margins. 

10. From this screen (with the reduced view of your page), click on the 
Print button, top left. This will give you another window. Click OK. 
Check the hard copy of your poem. 
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For Homework: 

Think of all the excuses that you have ever used for not having your 
homework done. Write them down. Create as many wild and original new 
excuses as you can think of. You should at least have a total of eight. See 
if you can make the last word of each excuse rhyme with the last word of 
the next so that you have pairs of rhyming excuses. This will be your 
Homework Excuses poem. You may want to begin it with: 

Dear Sir (Madam), 
I am very sorry to have to say 
My homework is not done today 
Because: 

• List each of your excuses ... 
• about your homework abuses! 
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Activity3 

Word Processing Your "Homework Excuses" Poem 

Word Processing Skills used: 

• loading the program 
• entering text from keyboard 
• using Bullets and Numbering 
• highlighting text 
• changing font, size and color of characters 
• using Page Set-up and Section Layout 

to change margins and vertically centre text 
• using the Spell Checker 
• saving your document 
• printing your document 

You are going to design your Homework Excuses poem in such a way 

that each excuse has its own unique appearance on the page. Usillg 

diffeNDt colors. FONT STYLE.sand s) IZ,JES. make 

eacheJLCU/j/blook DIFFERENT, 

1. Load the Word program from the Program Manager window. 

2. Once you have loaded the program, open a new document by going to 
the File menu and selecting New. Click OK at the window that asks if 
you will use the Normal template. 

3. Start typing your Homework Excuses poem. Separate each excuse by 
using Bullets and/or Numbering, for example: 

• The mice in my attic shred it to use for their nest. 
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1. Aliens landed and took my .homework as a speciment of 
excellence for their schools. 

You can do this simply by using the Tool bar (the strip of icons below 
the menu bar which contains the File, Edit, View ... pulldown menus): 

a. On the Toolbar, find the icon with the numbers 1 , 2, 3 and lines 
opposite these numbers and next to it the icon with the square 
bullets and lines opposite the bullets. 

b. Before you start typing each excuse, click on one of these ·icons with 
your mouse it will give a number {or bullet) and indent a few spaces 
from the number (or bullet) to where you can start typing the excuse. 
You can also insert numbers or bullets after you have typed your 
excuse. To do this, click with your mouse pointer to place your 
cursor at the beginning of the excuse you have typed. Then click the 
number or bullet icon. 

Note: If you are using numbers and you find that the wrong number is 
given when you click the icon, you will have to reset the 
numbers to where you want them to begin. To do this, open the 
Tools pulldown menu and seled Bullets and Numbering. 
Double click in the Start at box and erase the number. Replace 
it with the number you want to use next. 

Have you saved your work lately? 
Retne1nber how? 

See Activity 1 

Changing the Font Style, Size and Color for Each Excuse 

When you have completed typing your excuses, highlight each one of them 
in tum with your mouse (Remember how to highlight? Click and Drag? If 
not, check Activity 1, Step 3). With the excuse highlighted, you will change 
its font style and size. Remember that you have done this already in 
Activity 2, Step 4: 
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• Click on Format to show the menu and select Character. At the Font 
box, click on the down arrow to show all the different types of font styles 
you can choose from. Scroll through them and seled one. The sample 
window should show you what it will look like. 

• Click on the arrow next to the points box and select the font point size 
you desire. 

You can now change the color for this excuse: 

• With the Character window still open, click in the color box. Select the 
color you desire. Click OK. 

Now your poem is just about complete. Put a title on it if you haven't done 
so yet and don't forget to put your name at the bottom of the poem. All you 
have left to do now is to format and centre the poem on the page, spell 
check your document, save your work and print your poem. Do you 
remember how to do this? If you need help to complete these operations, 
go to Activity 2 and follow the instructions from Step 5 to the end of the 
activity. 

Printing Your Excuses Poem 

As this poem uses colored text, you will have to send your document to a 
color printer. 

• open the File menu and select Print Set-up. In the window that 
comes up, you should find the name of the color printer in your lab 
(If you do not know the computers name, go to the printer and read 
it or ask your teacher). Select the name of the color printer and 
click OK. 

Now you can print the document. Check how it looks first using Print 
Preview. 

For Homework: 

This time we will try to write a poem whose words form a certain shape on 
the page. When we word-process your poem next lesson, we will work on 
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shaping your poem to look like the object you desire. For now you will 
concentrate on writing a poem about the object you choose. For instance, 
you might write a poem about an apple (how it looks, feels, tastes, sounds 
when you bite it, smells when it's baking; how you feel when you eat it) or a 
poem about a snowball (how it looks, feels and tastes, the fun you can 
have with it, how you feel when making it and throwing it or being hit by it). 
Perhaps write a poem about ''Time" or the "Passage of Time" - What shape 
could you use for a poem about Time? There are limits to how well the 
word processor can make the shape you want, but choose any object you 
wish to write about and go to it! I Some other suggestions: 

• race car 
• leaf 
• snake 
• tree 
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Activity4 

Word Processing Your Shape Poem 

Word Processing Skills used: 
• loading the program 
• entering text from keyboard 
• highlighting text 
• alignment of text - left, right, full and center 
• using Section Layout to vertically center text 
• using the Spell Checker 
• changing the paper orientation 
• saving your document 
• printing your document 

Shape Poetry uses words to describe an object or idea and arranges those 
words in the shape of the object or idea being described. The reader is 
working with the mental images that your words have created and with the 
image created by the shape of the words on the page. 

Snowball 
Aging hands 

delve into newborn snow and 
extract, shivering, a memory. Eager 

hands, once again agile, shaping and mold 
-ing, memories unfolding. This ball of crystals 
reveals a distant past as fragmented in memory 

as the flakes of which it is formed. This hand-held 
sphere, with crystals like shards of broken mirror, 

reflects a child's rosy face, laughing, snowball in hand, 
taunting and teasing, chasing girls, puffing and wheez 
-ing, the past unfurls. And with once-deadly aim, a 

nostalgic throw. The fleeting memories go and 
smash· against . . . A stop sign on a lonely 
street as memories, splattered, slide down 

to the ground below, blending with 
the other snow on the ageless, 

slumbering ground 
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Before we start to shape your words into the objed you have written your 
poem about, first let•s enter the text of your poem into the word processor. 

If you still have not completed your poem continue to brainstorm on the 
computer. Pick the object you want to write about and type down ALL the 
words that come to your mind about that object as soon as they pop into 
your mind. Worry about deleting or rearranging the words afterwards. If 
someone else is still working on their poem, perhaps you can brainstorm 
together and bounce ideas off each other. 

Now with the poem that you have written about th~ object of your choice, 
you will attempt to arrange the words of your poem into the shape of the 
object you are writing about. To position the words on the page so that 
they take the shape you need you will use a number of word processing 
tools: 

• Alignment (left, right, center and full) 
• Space bar 
• Tab key 

With these tools you can create shapes like those on the following 
pages: 
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tree tree tree 
tree tree tree tree tree 

tree tree tree tree tree tree tree 
tree tree tree tree tree tree tree tree 

tree tree tree tree tree tree tree tree tree 
tree tree tree tree tree tree tree tree tree 

tree tree tree tree tree tree tree tree tree tree tree 
tree tree tree tree tree tree tree tree tree tree tree 

tree tree tree tree tree tree tree tree tree tree 
tree tre.e tree tree tree tree tree tree tree 

tree tree tree tree tree tree tree 
tree tree tree tree tree tree tree 

tree tree tree tree tree 
tree tree tree 

tree tree 
tree tree 
tree tree 
tree tree 
tree tree 
tree tree 
tree tree 
tree tree 
tree tree 
tree tree 

tree tree tree 
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le 
afle 

af leaf 
leaf leaf leaf leaf leaf 

leaf leaf leaf leaf leaf leaf leaf leaf leaf 
leaf leaf leaf leaf leaf leaf leaf leal 

leaf leaf leaf leaf leaf leaf leaf 
leaf leaf leaf leaf leaf leaf 

leaf leaf leaf leaf leaf leaf leaf 
leaf leaf leaf leaf reaf leaf leaf leaf 

leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf 
leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf 
le~le~le~~~~~~~~~le~le~~~~~~~ 

leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf 
leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf 

leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf 
le~~~le~le~le~le~~~~e~le~le~ 

leaf leaf leaf leaf leaf leaf leaf leaf leaf 
leaf leaf leaf leaf leaf leaf leaf leaf leaf leaf 

I 
e 
a 
f 
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By simply aligning the text to center the tree above was created. The leaf 
was a little more complicated to create as it required the use of the tab key, 
the space bar and centering. You will have to use a combination of 
spacebar and tab key (while the text is set to center alignment) and use 
your eye and judgement to create the shape you want. 

The word processing tools of Text alignment, spacing and tabbing can be 
operated by following easy steps: 

1. To adjust the Alignment of the text, it is easiest to use the icon buttons 
at the top of your screen. The group of four buttons for alignment may 
be found on the second row of buttons, about 5 buttons in from the 
right, looking something like: 

By pressing the first button, each line of text will line up along the left 
margin - left alignment 

By pressing the second button, each line of text will line up along the right 
margin - right alignment 

By pressing the third button, each line of text will line up in the center of the 
page - center alignment 

By pressing the fourth button, each line of text will spread out to take up the 
full space from the left margin to the right margin - full alignment 

2. The Tab key is used to indent I space words apart by a set number of 
spaces (usually about 6). It may be found on the left hand side of your 
keyboard above the Caps Lock key. 

3. The Space Bar advances the cursor by one space each time it is 
pressed and is found at the bottom of the keyboard. 

Let's try an exercise using some of these tools. Try to duplicate the (very 
loose) shape of race car below. Its shape was created typing the words 
"race car" over and over following these steps (Remember that "car'' must 
always come after "race" even if it must go on the next line): 
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1. First set your font to .. Utah .. or "MS Sans Serif' 14 point (if you don't 
recall how to do this, check Activity 2, step 4). 

2. Align text to center for the first seven lines. Type 3 words beginning 
with "race". Enter. Type 5 words. Enter. Type 6 words. Enter. Type 12 
words. Enter. 

3. For the fifth line, type 12 words. Put a space after every second word. 
Put cursor at the beginning of the first word of the fifth line and hit the 
space bar about 5 times until it the first word of the fifth line lined up 
under the fourth line. Put cursor at the end of the line and hit Enter. 

4. For the sixth line, type 13 words. Put a space after every second word. 
Put cursor at the beginning of the first word of the sixth line and hit the 
space bar about 5 times until it the first word of the sixth line hangs out 
a little further than the fifth line. Put cursor at the end of the line and hit 
Enter. 

5. For the seventh line, align text to Left. Hit the tab key twice. Type four 
words. Tab twice more. Space 6 times. Type 6 words. Enter. 

6. For the eighth line, Tab 2 times. Space 4 times. Type 3 words. Tab 4 
times. Type 3 words. Enter. 

7. For the tenth line, Tab 2 times. Space 7 times. Type 2 words. Tab 4 
times. Space 5 times. Type two words. Enter. 
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The race car on your screen should look something like this: 

race car race 
car .race car race car 

. race car race car race car 
race car race car race car race car race car race car 
race car race car race car race car race car race car 

race car race car race car race car race car race car race 
car race car race car race car race car race 

car race car 
car race 

race car race 
car race 

As you type your own poem. the number of words and the length of the 
words will vary. You'll have to adjust your spacing, tabbing and which lines 
will be aligned center, left, right or full. 

Experiment with Font style, size and color as you try to shape your poem. 
Remember when you are finished, your title should be at the top in a font 
size and style that is different and your name should be at the bottom, 
indented with the tab key. 

Do you remember how to vertically center your text so that it appears in the 
center of the page from top to bottom? If not check Adivity 2, Step 7. 

Be sure to Spell Check and Save your work! 

Printing Your Shape Poem 

If the shape of your poem will allow it, you may want to change the 
orientation of your page set-up. This means that you may print your poem 
on the page that is landscaped (with the page being wider across the top 
and narrower along the side of the page, in other words, with the page 
turned on its side!) as opposed to the more usual portrait page set-up (with 
the page being narrower across the top). 

• seled the Format menu and click on Page Set-up.. At the top of 
the window, click Size and Orientation. 

• In the Orientation box, click on Landscape. Click OK. 
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Now you can preview the poem to ensure that it frts on a landscaped page 
and then print it. 

Activity 5 

Creating a Resume I Personal Interests Inventory 

Word Processing Skills used: 

• loading the program 
• entering text from keyboard 
• highlighting text 
• cutting and pasting text 
• using the Spell Checker 
• saving your document 

As you move through school and out into the workforce, resumes or 
CVs (curriculum vitaes) become very important. They are a summary of all 
your education, skills and experiences which may be valuable to 
prospective employers. At this point in your education, you may not have a 
great deal of work experience, but you have had certain experiences and 
you do have personal interests, hobbies and valuable skills. Employers 
look not only for work experience but for a well-rounded person who has 
had many experiences and interests which may prove valuable in the 
workplace. 

It wou!d be a useful exercise to brainstorm all these skills, interests 
and experiences and try to summarize them in a resume or personal 
interest inventory. Work with the student at the computer next to you and 
try to jog each other's memory for the experiences, skills, and interests you 
have had to date. Typing your findings into the word processor as you go, 
try to think of every significant experience, skill or interest which you have 
had in the following areas: 

• education (your highest level of education achieved [i.e., the 
year you completed last] and the courses you are presently 
taking) 

• scholarships or awards (any awards that you have received 
through school, sports or other organizations) 
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• summer or part-time jobs (jobs for which you were paid or 
performed as a volunteer and the dates that you held these 
jobs) 

• work or chores at home (tending the garden, painting the 
fence, baby-sitting, etc. and the periods over which you 
carried out this work) 

• skills (abilities or talents that you may have, i.e., computer 
skills, painting, drawing, writing, wood-working, gardening, 
music, sports, etc.) 

• hobbies or interests (any past-time which interests you, i.e., 
constructing model cars, wood-working, painting, etc.; any 
group or organization that you belong to. i.e., Boy Scouts I Girl 
Guides, church groups, sports teams, etc .. Try to recall the 
dates when you were involved in these activities.) 

As you think of each activity and experience, type it into the word­
processor. When you have brainstormed all the important experiences and 
activities you have been involved in, now you should go back and fill in 
necessary details or summarize just the important details (deleting things 
that you don't need). 

For instance, you may have just come up with one word to describe 
your experience, for example, baby-sitting. You would need to give a little 
more explanation of this experience to show the responsibility you had. 
You would probably include information on the age of the child you took 
care of, for how many hours at a time, and the dates during which you had 
this responsibility. 

Perhaps you came up with too much information and will need to 
summarize and slim it down. For example, if you wrote: 

Played on the school football team, played 25 games as 
striker and 5 games as goalie, was assistant captain of the 
team. 

You may want to shorten it to: 

Assistant captain of the school football team. 

To shorten the first statement to make it look like the second, you will 
use the highlighting function, the delete key and the cutting and pasting 
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functions. You remember how to perform these functions from our first 
poetry exercise. For the cutting and pasting functions this time, try using 
the icons on the button bar (below the menu bar). For cutting, use the 
scissors icon; for pasting use the clipboard icon. 

To quickly shorten the first statement, you could: 

• highlight "assistant captain of' and cut it. 

• Then highlight "played on" and hit the clipboard icon to 
paste in what you have just cut. Now "played on" is 
replaced by "assistant captain of'. · 

• Then highlight all text after ·~eam" and hit the delete button. 

The name of the game in describing your experiences is to be brief, giving 
only the important and necessary information. 

Don't forget to spell check and save your work in a file called resume. 

Activity 6 

Word Processing Skills used: 

• loading the program 
• entering text from keyboard 
• highlighting text 
• changing font and size of characters 
• alignment of text - left, right, full and center 
• inserting text from another Word document 
• using the Spell Checker 
• saving your document 
• printing your document 

Now that you have all your significant information collected and 
summarized, you can start the important task of organizing and presenting 
it. We will use the word processor to format this document so that it looks 
neat and presentable. 

Your information should be saved in file called resume. Now you 
will start a new document which will be the framework of your resume. You 
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will fill in this framework document with the information from your resume 
document. 

1. Load the word program and open the resume document. 

2. Open a new document by opening the File menu and clicking on 
New, or by clicking on the new document icon (the blank sheet 
icon- the first button on the left of the button/tool bar). 

3. Save this new document as resume2 

4. You will start first by aligning to center your name, address and 
phone number on the top of the page. You remember how to 
align text using the buttons on the tool bar (Activity 4). 

5. Make your name stand out more than the rest of your address. 
How could you do this? 

You will now type into this document all the headings for the information 
that it will contain. 

6. Align the cursor to the left, hit your caps lock button and type the 
word EDUCATION. Highlight this word with your mouse and hit 
the bold and underline buttons on the tool bar. 

7. Type in other headings like SCHOLARSHIPS AND AWARDS, 
WORK EXPERIENCE, SKILLS, HOBBIES AND INTERESTS. 
Bold and underline these words as well. 

You now have the outline that your resume/personal interest inventory will 
take. You have only to drop the information into this document to fill it out. 
You will copy the information from the first document you created (which 
should be open now) and paste it into the new document outline, resume2. 

8. Open the Window menu. At the bottom of the menu you will see 
resume. Click on this to bring you to that document. 

9. Highlight with your mouse all the information you have typed on 
your education. Use the copy button on the tool bar to make a 
copy of this (Y au can also hold down the control button and hit the 
"C" key to copy). 
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10. Open the Window menu and click on resume2.. Move your cursor 
under the EDUCATION heading and paste in the information you 
have just copied by hitting the paste/clipboard icon (You can also 
hold down the· control button and hit the "V'' key to paste). 

You will arrange this information in a time sequence, starting with the most 
recent followed by the older information (chronological order). You will 
keep the dates to the left and indent the information from the left. 

11. Type the year and hitting the indent button twTee, type the 
information. As the typing scrolls onto the next lines, it will not 
line up with the tab you set for the first line. You will have to do 
this manually. Put the cursor at the beginning of each of the lines 
below the first and hit the indent button twice. 

When finished it should look something like this: 

1996- Year Seven studies at St. John's Comprehensive 
School, Epping, Essex County. Taking courses in: 
English, Maths, Science, Socials, French, 
Information Technology, ... 

1995 - 1996 Complete Year Six at name of school, community, 
county ... 

You will keep the same format for each of the headings in your resume­
dates to the left, information indented with the tab key from the date. Move 
the cursor below each heading, switch to the resume document, copy the 
necessary information, piece by piece, and paste them into the resume2 
document in the proper time sequence or chronological order (most recent 
experience first). 

Doner forget to save your work every ten minutes or sol 

When you have filled in all the necessary information under each heading, 
run a spell check, give your document a final read through, save and print 
your resume. 
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For Homework: 

As your next projed will be to create a newsletter, you will need story and 
content ideas. Write down as .many story and news feature ideas that you 
can come up with: the title of the newsletter, headline stories, interviews, 
surveys, comic strips, etc .. 
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Activity 7 

Using the Word Processor to Create a Newsletter 

Word Processing Skills used: 

• loading the program 
• entering text from keyboard 
• highlighting text 
• changing font and size of characters 
• alignment of text - left, right, full and center 
• setting out work with tab key 
• inserting text from another Word document 
• using WordArt 
• inserting work from Microsoft Draw 
• laying out work in columns 
• using the Spell Checker 
• saving your document 
• printing your document 

For the next couple of classes you will spend time assembling the material 
to put into your newsletter. Working in small groups, you will brainstorm 
news ideas and other features to include in your newsletter. 

Use the word processor to record your newsletter ideas. Create a file 
called news idea and keep a list of the stories,and features that your letter 
will contain. 

When you have finished this list, you can proceed to develop the stories 
and ideas. You may divide up the duties for developing the features, 
putting one person in charge of developing a story, another in charge of a 
conducting a survey or interview, etc .. 

It would be helpful if you kept one floppy disk for the whole group as a 
master of all the files that will be used in the newsletter. Name each file in 
a way that makes it easy to recognize what the file contains and as each 
file is completed copy it on to the master disk. (Do you remember how to 
specify which drive you are opening from or saving to?) You will later use 
all those files, cutting and pasting them into the main newsletter document 
(as you did in Activity 6). 
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When you have assembled all your material and saved it in separate files, 
you may begin formatting and assembling your newsletter. 

Formatting the Newsletter 

You will no doubt have a lot of material to put in your newsletter and you 
will likely need to maximize your space on the page, using as much of the 
page as possible. You should therefore adjust your left, right, top and 
bottom margins to be narrower. (You may remember how to do this from 
formatting your poetry). 

The Title 

Let's begin with the title. Type the title of the newsletter, highlight it, select 
a distinc1ive font and enlarge the font size so that it takes up the width of 
the page. 

Using Microsoft WordArt 

You may wish to make your title more distinctive by using WordArt: 

• Pull down the Insert menu and seled Object. In the window that 
appears, find and select Microsoft WordArt 2.0. 

• Type the title of your newsletter in the box, Enter Your Text Here. 

• Below click on Choose a Shape box and select the shape you want 
your title to take. 

Within WordArt, experiment with the font style, size, color, alignment, 
stretch, etc. until you are satisfied with your title and then hit the Apply 
button. and then hit OK. 

Editing your WordAtt title 

If the title is not to your liking, you can edit it: 

• click on the title with your mouse and you should see a grey frame 
appear. 
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• pull down the Edit menu and sel~d Microsoft WontArt 2.0 Object. 
This will bring you back to the WordArt window and you can change 
the design. 

You can also change the shape of the your WordArt title, by clicking and 
dragging on any of the little grey blocks in the WordArt object's frame. For 
instance, if the title doesn't span the whole page, place your cursor on the 
button on the right side of the frame and click and drag the title across the 
page until it takes up the whole width. 

Below the title, in smaUerfont (perhaps Times New Roman, 12 point), type 
the name of your school and the date .. Place the cursor at the beginning of 
the date and hit the tab button until the date is aligned to the right of the 
page. 

Drawing a Line or Other Object with Microsoft Draw 

Let's separate the newsletter's title from the rest of the paper with a line. 
The Word program does not have a ready-made line to insert so you'll 
have to draw one yourself using the Microsoft Draw Program 

• Place the cursor of the end of the date and hit return. 

• Click on the Microsoft Draw icon on the tool bar (about the eighth 
button in from the right - with a circle, triangle and square on it). 

• Choose the straight line button, third down the left side of the 
window. Click and drag yourself a line across the window. 

• Pull down the File menu and select update. 

• Hold down the AL T key and hit the tab key until you see the Word 
program icon and title come up or just click your mouse inside the 
Word window to bring the Word program window forward again. The 
line you have drawn should now appear beneath the place and date 
of your newsletter. (If this fails, try copying the line in the Draw 
window and pasting it into place in the newsletter). 

• The line will not be long enough to reach across the width of the 
page. You will have to click and drag it to the right length. Click on 
the line with the mouse until the grey frame appears. Click and drag 
on the right side of the frame until the line reaches across. 
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You may want to use this line again to separate stories in your newsletter. 
You can either repeat the above steps or simply click on the line that you 
have created, copy it and paste it where it is needed. 

Note: You may want to refer back to these steps as you perhaps may use 
MS Draw to create your own pictures or comi~ strips to include in the 
newsletter. 

The top of your newsletter should look something like this: 

The 
CDIJiprehensive 

St. John's Comprehensive School September 30, 1996 

ive 
St. John's Comprehensive School, Epping September 30, 1996 

The Main Headline 

The next feature to follow may be your main headline. The headline font is 
usually the same as the font you will use throughout the newsletter 
(perhaps Times New Roman). Choose a larger font size to make the 
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headline stand out. Center the Headline. (Note: The smaller stories to 
follow will have smaller font size). 

The Columns 

Placing the cursor of the end of the headline and hitting return, you will now 
need to set out your document in columns: -

• Pull down the Format menu and select Columns~ Increase the 
number of columns to four (or less). Click on the Apply to box and 
select This Point FoTWard. 

Note: It would be best to look at tha document in Page Layout format so 
you know what your page will look like: 

• Pull down the View menu and select Page Layout 

Everything after this that you type will appear in column form. The program 
will continue with one column until it fills up the whole page before starting 
another column. But you may wish to stop a column at a certain length and 
continue your writing in the next column. You can insert a column break 
by: 

• placing your cursor at the end of the line where you want to begin a 
new column and pull down the Insert menu, selecting Break. 

• click on Column Break and click OK. 

Inserting the Text of the News Story 

You are ready to drop text into the columns you have set up. First thing to 
do is to set your alignment of text to Full. This allows the text to take up the 
full width of the column. 

You have probably already typed the story into another file which should be 
on the Master disk for your group. You can copy and paste the text of this 
file into your newsletter as you did in Activity 6, but there is another way to 
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insert the text of a file when you want to use the whole file in the order in 
which it is written: 

• pull down the /nsert.menu and seled File. 

• select the a: drive, select the file you want and click . 

Your story will likely appear as one column. Insert column breaks at points 
in the column so that your story spans the page in the number of columns 
that you have set up. 

Inserting Clipart into Your Newsletter 

You may want to include some graphics which may relate to your news 
story. Insert clipart by: 

• placing your cursor where you want the graphic inserted. 

• pulling down the Insert menu and selecting pidure 

• In the Directories box, find the clipart diredory and select it. A 
number of files should appear. You will have browse through 
them to see if they suit your purposes. You can preview the 
graphic in the file by selecting a file and clicking the Preview 
button. 

• If the graphic is suitable, click OK and it will be inserted where 
your cursor was. 

Your first story could look something like the one on the following page: 
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'n1 ~;um rent~n•'' 
St. John's Comprehensive School, Epping September 30, 

A New School Year Begins at St.John'~ 
Much rejoicing could be heard 
for miles around this month as 
students made their way to 
school to begin a new academic 
year. Students could not hide 
their joy (or their ear-to-ear 
grins) as they made their way 
through the doors of their 
beloved school after a refreshing 
summer break. Some students 
were heard to excl~ "Thank 
goodness, we don't have to 
spend anymore long hours in the 
hot summer sun playing 
football!" Others were over-

heard to gleefully say, "I can't 
watt to get back to some 
challenging maths problems and 
rewarding science experiments!" 
Still others were overjoyed at the 
prospect of tackling such 
satisfying IT projects as 
newsletters! All over the school 

eager yelps of sheer bliss 
be heard from the mou1 
students busily ap 
themselves the happy ta.s 
their education. With a 
excitement and enthusiasm 
no wonder that the 
Teacher could be heard tt 
"These students make corn 
school each day such an e) 
pleasure for me and the S1 

St. John's that I'll as' 
Governors to lengthen the ~ 

year." 

When you start shorter news articles, you may use more (and consequently narrower) 
columns. If a news item takes up only one column, you can insert vertical lines betweE 
the columns in the column set-up. For example, see next page: 
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\Joes untine 
This school year will 
mark the beginning of St. 
John's Comprehensive 
School's journey into 
cyberspace. With the 
acquisition of two full 
multi-media, lap-top 
computers, the school 
now has Internet access 
and email capability for 
students and teachers. 

~ ~ 

~ (;oiu;.: (Juline ~ 
ih~ 
~ 
;:· 

1 
~ ~ ~ 

~ ~ ~=l~~~:-::::t'P"x:~1:7.~;~~{"$%::;;x:-#~~=:.~:,J 
YOU KNOW YOU'VE 

BEEN ON THE INTERNET 
TOO LONG WHEN ... 
... you are reading a book 

and look for the scroll 
bar to get to the next 
page. 

From Newfoundland 
comes the SchooiNet 
RINGS Project. The 
project consists of a 
number of participating 
classes or local RINGS 
working together online 
on a project over the 
Internet. Local RINGS 
can be made up of 
groups of students 
anywhere in the world. 

Latest developm1 
the alien-o1 
Summer of '96: :M 
might not just 
Saturday-morning 
toon figment; then 
be life on Man 
Augu~ a meteo1 
Mars fell to 
Scientists found fo 
organic life 
suggests that ther1 
was life on 

When you see both of these elements combined will · like. See the next page: ' you get an •dea of what your completed newsletter will I• 
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'nt: ~;vm rBRfiRIII 
St. John's Comprehensive School, Epping September 30, 1 

A New School Year Begins at St.John's 
Much rejoicing could be heard 
for miles around this month as 
students made their way to 
school to begin a new 
academic year. Students could 
not hide their joy (or their ear­
to-ear grins) as they made their 
way through the doors of their 

over the school eager yel 
sheer bliss ~ould be heard 
the mouths of students t 
applying themselves the h 
tasks of their education. 
all this excitement 

beloved school after a 
refreshing summer break. 
Some students were heard to 
exclai~ "Thank goodness, we 
don't have to spend anymore 
long hours in the hot summer 
sun playing football1" Others 
were over-

heard to gleefully say, "I cant 
wait to get back to some 
challenging maths problems 
and rewarding science 
experiments~" Still others 
were overjoyed at the prospect 
of tackling such satisfYing IT 
projects as newsletters! All 

enthusiasm, it is no we 
that the Head Teacher cou 
heard to say: "These stu4 
make coming to school 
day such an extreme plec 
for me and the staff o1 
John's that I'II ask 
Governors to lengthen 
school y 

St. John's 
Goes Online 

This school year will 
mark the beginning of 
St. John's 
Comprehensive 
School's journey into 
cyberspace. With the 
acquisition of two full 
multi-media, lap-top 
computers, the school 
now has Internet 
access and email 
capability for students 
and teachers. 

lr'''"~"*""''''''"@. ,,,,, ' ;;:: 

~ ;\::; ;·:; :::::·:::.::: ;;:::;:: :: ;:;::::·::::::::::: ~=:: :·::: : ,._.,, ~-: : 

YOU KNOW YOtfVE 
BEEN ON TilE 
INTERNET TOO LONG 
WHEN ... 

. . . you are reading a 
book and look for the 
scroll bar to get to the 
next page. 
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Net News 
From Newfoundland 
comes the SchooJNet 
RINGS Project. The 
project consists of a 
number of participating 
classes or local RINGS 
working together 
online on a project 
over the Internet . 
Local RINGS can be 
made up of groups of 
students anywhere in 
the world. 

Life on M 
Latest developm~ 
the alien-ob: 
Summer of 
Martians might nl 
be a Saturday-me 
car-toon figment; 
could be life on 
In Augu~ a n 
from Mars fell to 
Scientists fourid : 
of organic life 
suggests that 
once was life on 



You now have all the skills you need to produce 
an impressive looking newsletter. All you need to 
do now is apply your creativity and play around 
with the layout~ Good luck/ 
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